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11.2

Welcome to AccuTerm 7 Lite

Introduction

Welcome to AccuTerm 7 Lite. We've worked hard to give you the fastest and most accurate terminal
emulation package on the market. We hawe also tried to make it easy to use. Our philosophy has been
to add the features that will be most useful without sacrificing ease of use, accuracy or performance.

Please refer to one of the following topics for detailed information about features, requirements,
installation and use of AccuTerm 7 Lite:

Usage Guidelines

Features of AccuTerm 7 Lite
Hardware and Software Requirements
Running AccuTerm 7 Lite

AccuTerm 7 Lite Menu

Configuring AccuTerm
Auto Dialer

Usage Guidelines

Trial Version

When you first install AccuTerm on a new computer, it will run in "evaluation mode" for 30 days, or until
you enter an activation code to activate the software. During the trial period, the program is completely
functional. We encourage you to use the program in your own operating environment to determine if it
will meet your expectations, prior to purchase. When the trial period expires, the program will cease
running, except to allow the entry of an activation code. You are free to share your trial copy of
AccuTerm with others so that they may also evaluate the software.

Single User Version

By entering an activation code for a Single User License, you can activate your trial version at any time.
A Single User License allows you to install the program on one computer, or for use by one thin client
user in a sener environment. All program features are enabled.

Multi User Version

By entering an activation code for a Multi User License, you can activate your trial version at any time.
You can also increase the number of licensed users, or convert a Single User License to Multi User
License by entering an appropriate activation code. A Multi User License allows you to install the
program on a limited number of computers, or for use by a limited number of thin client users in a sener
environment. The total number of users (individual computers or thin client users) must not exceed the
license count specified on your invoice or product media. You can use the program's About Box to view
the number of users you are allowed to install. Under the Multi User License, users refers to installed
users, not concurrent users. All program features are enabled.

Features of AccuTerm 7 Lite

AccuTerm 7 Lite is a feature-reduced version of AccuTerm 7. This version provides the same terminal
emulation and connectivity features available with the Standard version of AccuTerm 7, but does not
include the extended functions such as scripting, file transfer and GUI.

Copyright © 2010-2014 Zumasys, Inc.
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Accurate emulations: AccuTerm 7 Lite provides emulations for ADDS Viewpoint A2 & 60, Wyse 50 &
60, MDIS P30, VT52, VT100, VT220, VT320 & VT420, SCO & Linux Console, Pick PC Monitor and
Tektronix 4010, 4014 & 4105 terminals.

Connections: AccuTerm 7 Lite supports Serial, Dialup, Telnet, Secure Shell (SSH vl & \2) and SSL/
Telnet connections. SSH sessions support password, keyboard interactive and public key
authentications. Telnet and SSH connections support IPV6. SSL/Telnet provides secure connections by
tunneling a telnet session through an SSL or TLS connection.

Extended Screen Support: AccuTerm 7 supports screen sizes up to 240 columns, 240 rows and 25
pages. The integrated scrollback buffer supports up to 10,000 lines for instant recall.

Full Color Mapping: Screen colors are fully customizable. You can choose any foreground and
background color combination for any terminal visual attribute.

Keyboard: all normal and shifted function and keypad keys are user-programmable.

Clipboard: AccuTerm 7 fully supports copying data from the screen to the clipboard, and pasting data
from the clipboard back to the host.

Unicode / UTF-8 supported in all emulations, the GUI Dewvelopment Environment, the wED Editor and
Kermit and Zmodem file transfers.

1.1.3 Hardware and Software Requirements

Memory: 512MB

Processor: Pentium 4 or better

Windows: XP SP2, Vista, Windows 7, Windows 8, Server 2003, Server 2008
Communications Any serial port, modem or network adaptor supported by Windows
interface:

Mouse: Any mouse supported by Windows

114 Installing AccuTerm 7 Lite

AccuTerm 7 Lite is available as either a downloadable install file or on CD. To install AccuTerm 7 Lite
from a CD, insert the CD and select "Install AccuTerm 7 Lite" from the auto-run menu. If there is no auto-
run menu, you can install AccuTerm by browsing the CD with Windows Explorer and double-clicking the
installation file in the ‘atwin70' folder.

To install from a downloaded install file, either choose "Run" from the "Download Complete" box, or use
Windows Explorer to browse to folder where the install file was downloaded and double-click to start the
installer. The installer will then guide you through the installation process, as outlined below in the
following step-by-step instructions.

1. The Software License Agreement is displayed. Please review the agreement, then click
OK to accept the license and continue the installation.
2. The Welcome screen is displayed. The installation begins when you click the Next button.

Copyright © 2010-2014 Zumasys, Inc.



AccuTerm 7 Lite Help

3. Select the desired installation type: Normal, Standalone or Portable.

Normal: installs AccuTerm 7 Lite using a traditional installation process for Windows
programs. Program files are installed in the C:\Program Files\Atwin70 folder. Shared
DLLs are installed in the Windows\System32 folder, and the registry is updated to
establish file associations as well as component file registration. Administrator
privileges are required for this type of installation. Note: when installing on a server
running Terminal Services or Citrix, you must use Control Panel "Install Application on
Terminal Sernver" to install AccuTerm 7 Lite.

Standalone: installs AccuTerm 7 Lite as a "standalone" application. All component
files are installed in the AccuTerm program folder (no files are installed in the
Windows\System32 folder). File associations are stored in the user's area of the
registry (unless you have administrator privileges). Component file registration is
transient and only affects the user's area of the registry.

Portable: installs AccuTerm 7 Lite on a portable device such as a USB flash drive or
removable hard drive. This is similar to the Standalone installation, except that no file
associations are stored in the registry. The Portable installation allows you to take a
copy of AccuTerm with you when you work on multiple machines and run it without
further installation on any XP-SP2 or later version of Windows.

4. Select the directory where you want the AccuTerm 7 Lite program files to be installed, then
click the Next button. The default installation directory is "C:\Program Files\Atwin70". If you
have a prior version of AccuTerm (97, 2000 or 2K2) installed on your computer, you should
choose a different directory for installing AccuTerm 7. Note: if you have the Standard or
Internet Edition of AccuTerm 7 installed, you must install AccuTerm 7 Lite in the same
directory as the Standard or Internet Edition version.

5. Select a “home” directory. The default “home” directory is the current user's “My
Documents” directory. This is the place where AccuTerm will start when opening or saving
session configuration files. After selecting the “home” directory, click the Next button.

6. Select a “Start Menu” folder for the AccuTerm 7 Lite shortcut. If you would like a shortcut
(icon) for AccuTerm 7 Lite placed on your desktop, select the Place shortcut on desktop
option. If you want the shortcut to be available to all users of this computer, select the
Make shortcut available to all users option. Click the Next button.

7. Choose whether you want files which are replaced during installation to be saved in a

backup directory. If you select this option, when you click the Next button, you can choose

the directory where replaced files are saved.

To begin installing files, click the Next button. The installation progress will be displayed.

9. When the program files have been installed, you can enter your Product Activation Code
by clicking the Enter Activation Code button. You can always enter the code at a later
time from AccuTerm's Help menu. Click Finish to complete the installation.

©

After installing AccuTerm 7, you can launch it from the Start Menu or desktop icon. Use the
Connection Wizard to create a new session and log in to your host system! If you selected a portable
installation and opted to create a launcher, you can launch AccuTerm by double-clicking the "Start
AccuTerm 7 Lite" batch file in the root of the portable drive.
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1.2 Running AccuTerm

To run AccuTerm 7 Lite, simply select AccuTerm 7 Lite from the Start menu, or click the AccuTerm
icon on the desktop. AccuTerm’s main window and Welcome screen will be displayed.

E AccuTerm 7 Lite

From the Welcome screen, you can choose to create a new session, open an existing session or open
a session which was recently used.

Creating a New Session
Create a new session by selecting the Create new session option from the Welcome screen, or by

using File » New from the main menu or by clicking the D button on the toolbar. The Connection
Wizard will open to guide you through the session creation process.

Shortcuts

After saving a session file (.atcf) you can create a shortcut to the file so that AccuTerm automatically
opens that session. To create a shortcut, use Windows Explorer to find the session file (usually in the
My Documents folder). Right-click on the desired file. Select Copy from the popup menu. Position the
mouse where you want to create the shortcut (desktop, Start menu, etc.) Right-click and select Paste
Shortcut from the popup menu. If you created the shortcut on the desktop, double-clicking the new
shortcut icon will start AccuTerm and open the desired session. If you created the shortcut in the Start
menu, selecting the new menu item in the Start menu will do the same.

Once you have opened (or created) a session, AccuTerm will establish a connection to the host
specified in the session file. You will receive a warning message if the connection could not be
established (network timeout, port not available, etc.).

lzlsl
EVE
If you have opened a dialup session, click the dialer icon lliv’"g on the toolbar to display the dialing

dialog. Enter the phone number (or select the number from the list of recent numbers) of the remote host
that you want to connect to, then click the Dial button. To disconnect, click the dialer icon, and click
the Hang Up button in the dialing dialog.

See also:

AccuTerm Lite Menu

Connection Wizard

Settings Dialog

Dialer (dialup or modem connection)

1.2.1 Connection Wizard

The Connection Wizard helps you configure a new session by letting you choose the most common
settings using a wizard-style dialog. If you do not want to use the Connection Wizard, a check-box is
provided to bypass the wizard in the future.

At any time you can skip the rest of the wizard and open the Settings dialog by clicking the Session
settings button.

Copyright © 2010-2014 Zumasys, Inc.
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1.2.1.2

1.2.1.3

12131

Connection Options

Choose the connection type for your new session from the Connection Options page. Choices are
Telnet, Secure Shell, SSL/Telnet, Serial Port or Modem. After selecting the connection type, click the
Next> button.

Telnet Connection

After selecting Telnet as the connection type, enter the host name or IP address that you would like to
connect to. Click the drop-down arrow to display a list of recently used hosts.

If you know the type of the host system, select it from the drop-down list. If you do not know the type,
leawe it set to "default".

If you know that your host's telnet sener is using a non-standard TCP port number, enter the port
number. The default port number for Telnet is 23. Note: some host types use a non-standard telnet port.
Choosing the correct host type is important for these hosts.

After entering the host details, click the Next> button to choose the terminal type.
Secure Shell Connection

After selecting Secure Shell as the connection type, enter the host name or IP address that you would
like to connect to. Click the drop-down arrow to display a list of recently used hosts.

If you know the type of the host system, select it from the drop-down list. If you do not know the type,
leawve it set to "default".

If you know that your host's SSH senver is using a non-standard TCP port number, enter the port
number. The default port number for SSH is 22. Note: some host types use a non-standard SSH port.
Choosing the correct host type is important for these hosts.

After entering the host details, click the Next> button to choose the terminal type.
Serial Port Connection

After selecting Serial Port as the connection type, select the port number you are using to connect to
the host computer from the drop-down list. Note: the port number in this screen is the serial, or COM
port, that is built into your PC, not the port number on the host computer.

Some computers do not have built-in serial ports. If this is the case, and you need to use a serial port to
connect to your host, you may be able to use a USB Serial Port adapter. This is a cable with a USB
connector on one end and a 9-pin serial connector on the other.

After selecting the serial port, click the Next> button to choose the port settings.
Serial Port Settings

After selecting the serial port number, select the port settings that match the serial port on the host
computer you are connecting to. Generally these settings must be that same on both serial ports (the
one on your PC and the one on the host computer).

Baud rate

Baud rate is the speed that the serial port communicates with the host computer. AccuTerm supports
baud rates from 300 to 115,000 baud. If your PC is connected directly to the host machine, you will
most likely use 9600 or 19200 baud. The speed that you use depends on the host computer. If you
select the wrong baud rate, you screen may appear garbled or you may get no response from the host

Copyright © 2010-2014 Zumasys, Inc.
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when you type on the keyboard.

Data bits
This refers to the number of bits the serial port sends to represent the actual character. The options are
7 or 8 bits (the default is 8 bits). This setting must match your host system.

Stop bits
This is the number of bits that the serial port uses to separate each character sent. The options are 1 or
2 stop bits (default is 1). This setting must match your host system.

Parity

Parity is an error checking mechanism performed by the serial port. The options are: None, Odd, Even,
Mark and Space. The most common is None (this is the default). This setting must match your host
system.

Handshake

AccuTerm supports three methods of handshaking. The first and most common is. Xon/Xoff (or software
handshake). With this method, AccuTerm sends a special Xoff character (DC3) to the host system when
it wants the host to stop sending characters. When the AccuTerm has caught up, it sends the Xon
character (DC1).

The second handshake method supported by AccuTerm is DTR/DSR. This method is referred to as
hardware handshake because it physically changes the wltages on the serial port to indicate whether
the receiving computer is ready.

The third method, RTS/CTS, protocol works the same as DTR/DSR except it uses a different pair of
signals (pins) on the serial port.

For DTR/DSR or RTS/CTS handshake to work, the cable which connects the PC and the host computer
must connect the appropriate handshake signals at both ends. Physical cable wiring is beyond the
scope of this reference.

After selecting the serial port settings, click the Next> button to choose the terminal type.
1.2.1.4 Modem (dialup) Connection

After selecting Modem as the connection type, select the modem you would like to use from the drop-
down list. All modems that are installed in your computer should be displayed in the list. Note: if the
modem you are looking for is not in the list, then AccuTerm was unable to identify that modem.
Sometimes updating the modem driver will correct this.

After selecting the modem, click the Next> button to choose the terminal type.
1.2.1.5 Terminal Type

In order for AccuTerm to work properly with terminal-based applications, the terminal type that AccuTerm
is emulating must match the terminal type the host application is configured or designed to use. Select
the terminal type (emulation or personality) from the drop-down list. If you select the wrong type, your
screen will probably be scrambled, and you should try a different type.

After selecting the modem, click the Finish button to close the wizard.

See also:

Copyright © 2010-2014 Zumasys, Inc.
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1.2.2

123

Terminal types supported by AccuTerm 7
Reconnect

When you are connected to a host using Telnet or SSH, and the connection is terminated by the host
(for example logging out of a Unix host will terminate the connection), a disconnect notice is displayed
on the terminal screen. The disconnect notice has three options: Reconnect, Close and Cancel. If you
click the Reconnect button, AccuTerm will attempt to reconnect to the host. If you click Close,
AccuTerm will close the session. If you click Cancel, the reconnect notice is cleared (yoq can

reconnect later by choosing Tools » Reconnect from the main menu or by clicking the 9 button on
the toolbar.)

Dialer

The Dialer dialog is used to enter the phone number you wish to dial for a dialup, or modem,

connection. It is also used to disconnect an active dialup connection. The dialog is opened by clicking
1]2]3
e

the 21253 putton on the toolbar, or by selecting Dialer from the Tools menu.

Connecting
Enter the phone number you want to connect to in the Number field. Optionally, enter a descriptive
name in the Name field. Click the Dial button to dial the number.

The dialer remembers the last 10 numbers you have dialed. You can click the drop-down arrow to select
a phone number from the list.

Disconnecting
To disconnect an active call, click the Hang up button.

Dialing properties
Click the Dialing properties button to open the Windows Phone and Modem Dialing Rules dialog.
Use this dialog to select your dialing location, area code rules, calling card, etc.

Quick Dial
K1 FTE
. o B2 _ .
You can click the drop-down arrow next to the phone icon 2253 on the toolbar to display a "quick dial”
menu. Select one of your recently used phone numbers from this list to dial. If you have an active

connection, you can choose the Hang Up option from this menu to disconnect.

Copyright © 2010-2014 Zumasys, Inc.
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1.3 Product Activation

You can activate AccuTerm 7 Lite immediately after installation by clicking the Enter Activation Code
button on the final screen of the installer. You can also enter your activation code at any time by
selecting Enter Activation Code from the Help menu.

To complete the product activation process you will need to enter some information about yourself or the
company you work for. Most fields are optional, however you must enter either a user name or company
name (Small Business and Enterprise licenses require company name and location).

As part of the activation process, the registration information on the Activation screen can automatically
be sent to Zumasys securely over the Internet. Check the Send registration details... check box to
enable this feature; un-check to disable. Although registering your product with Zumasys is optional, we
highly recommend doing so because it enables us to provide superior support if you should contact us
about lost activation codes, upgrades or software problems.

If you are a local administrator for your computer, you can check the Activate all users... check box.
You may be prompted to enter your administrator password or respond affirmatively to the User Account
Control dialog.

Copyright © 2010-2014 Zumasys, Inc.
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1.4

141

14.2

AccuTerm User Interface

Main Menu

The main menu is displayed immediately below the main window title bar. It is used to control the
AccuTerm application. The main menu contains top-level menu items for File, Edit, Screen, Tools and
Help. Clicking one of the main menu items displays a sub-menu with items relating to the top-level item.

Toolbar

The Toolbar is shown below the main menu. The Toolbar contains buttons that duplicate some of the
menu items, a kind of shortcut for the menu item. If you let the mouse hover over a toolbar button, a
small description of the button's action will be displayed.

Status Bar

The Status Bar is displayed at the very bottom of the workspace window. The Status Bar indicates
various status information about the terminal session, such as the keyboard state (locked or unlocked),
the cursor position, screen size, terminal type, printer status and connection status.

Keyboard Commands

Previous Page - CTRL+PGUP

Displays the previous terminal page. To use this command, the session must be setup with more than
one video page. Note: this command changes pages in the terminal page memory, not the history
(scrollback) buffer.

Next Page - CTRL+PGDN
Displays the next terminal page. Note: this command changes pages in the terminal page memory, not
the history (scrollback) buffer.

Pause / Resume - SCROLL LOCK
This command pauses or resumes the processing of received data by the terminal. The keyboard
"Scroll Lock" LED indicates the current status.

Scanning the History Buffer (Scrollback)
Use CTRL+SHIFT+PGUP, CTRL+SHIFT+PGDN, CTRL+SHIFT+UP, CTRL+SHIFT+DOWN,
CTRL+SHIFT+HOME, and CTRL+SHIFT+END to navigate the history (scrollback) buffer.

Besides using the keyboard to navigate the history buffer, you can also use the mouse wheel. Just scroll
the mouse wheel up or down to scroll the history.

Note: in order to scan the history buffer, you must specify the number of history rows to remember in
Screen Settings.

Selecting text

To select a block on the screen, position the mouse on the upper left corner of the desired block. Press
and hold the left mouse button for about one half second, then drag the mouse to the lower right corner,
and release the button. The selected area will be indicated by a dotted rectangle. To remowve the
selection, click the left mouse button anywhere on the screen. If the screen needs to be scrolled to
select the desired data, move the mouse to the edge of the window and the window will automatically
scroll in that direction.

You can copy selected text to the clipboard by choosing Copy from the Edit menu or by clicking the

I% toolbar button. If you have enabled the Ctrl+C or Ctrl+insert shortcuts, then you can use the shortcut
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key as well.

To clear the selection, click with the left mouse button anywhere on the screen, or choose Select None
from the Edit menu.

Copyright © 2010-2014 Zumasys, Inc.
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1.5 AccuTerm Main Menu

As is common in most Windows applications, AccuTerm 7 Lite provides a menu and toolbar to control
the program. The menu provides complete control, and the toolbar provides quick access to the most
common functions. The menu functions and toolbar buttons are described in this topic.

File Menu
The Eile menu contains options for creating, opening, closing and saving sessions, and to print the
screen. Common menu options may also be performed by clicking a button on the toolbar.

Eile » New...

To create a new terminal session, select the New option or click the D button on the
toolbar. A new session will be created, and the Connection Wizard will be displayed so you can
configure the new session.

File » Open...
“=l

To open an existing session configuration file, select the Open option or click the == putton
on the toolbar. If a session is currently open, it is closed, and a new session is opened using
the settings from the selected configuration file.

File » Save and Eile » Save as...
After creating a new session or modifying session settings, save the new settings in a session

configuration file by selecting the Save or Save as option, or by clicking the E button.

File » Print screen

Selecting this menu option or clicking the é‘a button option causes the current terminal
screen to be printed on the selected screen printer.

Recent Files
Opens one of the most recently opened terminal session configuration files.

Eile » Exit
Select this option to terminate AccuTerm 7 Lite.

Edit Menu

The Edit menu contains commands to copy and paste from the Windows clipboard and select the
screen.

Edit » Copy
This command will copy a selected block of text from the terminal screen to the Windows

clipboard. If there is no selection, the entire screen is copied. You can also click the I%
button to perform this function. For more information, see Selecting Text.

Edit » Paste
This command will send the clipboard contents to the host computer. See Clipboard options for

=
line-end and paste-end options. Clicking the L@ button will also perform this function.
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Edit » Select » Screen
This command will select the entire screen. You will see a dotted rectangle around the

selection.

Edit » Select » All
This command will select the entire screen and all history. You will see a dotted rectangle
around the selection.

Edit » Select » None
This command will remove any selection and erase the dotted rectangle.

Screen Menu
The Screen menu contains commands to adjust the screen size (80 or 132 column) and reset the

screen.

Screen » Normal (80 cols)
v

Select this option or click the @ button to shift the screen from Extended to Normal size

Screen » Extended (132 cols)

Select this option or click the i button to shift the screen from Normal to Extended size.

Tools Menu
The Tools menu contains options for modifying AccuTerm’s settings, dialing a number, or reconnecting
to the host after a session has been disconnected.

Tools » Settings...

Select this option or click the i ~ button to open the Settings dialog box. This dialog is used
to modify all of AccuTerm 7 Lite’s settings and preferences, such as communications device,
terminal type, screen colors, etc.

Tools » Dialer...
Select the Dialer option to enter or choose a phone number to dial when using a dialup, or
modem, connection. Also choose this option to disconnect an active dialup connection. Note:

this option will be disabled unless the connection type is "Modem". You can quickly call up

AT
4]5]

the Dialer dialog by clicking the ZIZ& button on the toolbar.

Tools » Reconnect
Resets the connection. If the session has been disconnected, this command will attempt to

reconnect. You can quickly reset the connection by clicking the 9 button on the toolbar.

Help Menu
The Help menu contains options to display online help, documentation and program information. It also
provides a function to enter your product activation code. You can get context-sensitive help at any time

by clicking the 0 button.
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Help » Contents

This menu item will open the online help to the Contents tab, where you can browse the topics
to locate the information you need.

Help » Index

This menu item will open the online help to the Index tab, where you can search help topics by
keyword to locate the information you need.

Help » Enter Activation Code
Select this menu item to open the Product Activation dialog to enter your activation code.

Help » Documentation
This menu item will open the User Manual, Release Notes, or the Software License Agreement.

Help » About AccuTerm
This menu item will open the About AccuTerm dialog which displays the product copyright
notice, serial number, release, license summary, and registration information. A link is provided
to check for product updates.
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1.6 Configuring AccuTerm

To modify AccuTerm’s settings, use Tools » Settings... from the main menu or click the i ~ button
on the toolbar.

AccuTerm's settings are organized into categories which are shown in a nested tree structure, with
similar categories as branches from a common parent category. The tree is displayed on the left pane of
the Settings window. When you select a category from the tree by clicking on it, the settings for that
category are displayed in the right pane.

When you have completed your changes, simply press ENTER (or click the OK or Apply button) to save
changes, or press ESC (or click the Cancel button) to discard changes and close the Settings dialog
box.

Category:
General Options
Connection
Telnet
Secure Shell
Private Key
SSL/Telnet
Serial Port
Modem
Terminal
Screen
Colors
Attribute Colors
Palette
Keyboard
Font & Character Set
Sounds
Printer
Screen Print
Slave Printer

Clipboard

1.6.1 General Settings

The General Options are applicable to the overall operation of AccuTerm and are not associated with
any particular session. Some of these settings allow you to re-activate features that have been
previously disabled, like showing the Welcome screen.

Default folder for session files

This field specifies which folder to start in when opening or saving a session file. Once you have opened
or saved a session file, open or save will start with the last folder used. The default folder for session
files is the current user's My Documents folder.

Show welcome page at startup
Check this option to show the Welcome screen when AccuTerm first starts up.

Use connection wizard when creating new sessions
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Check this option to open the Connection Wizard when you create a new session. If this option is un-
checked, use the Settings dialog to configure the new session.

Warn before disconnecting

If this option is checked, then when you attempt to close a session which is currently connected to the
host (Dial-up, Telnet and Secure Shell connections), you will receive a warning that the session is still

connected. You can then choose to cancel, leaving the session open, or continue closing the session.
When this option is not checked you will not receive this warning.

Remember Caps Lock and Scroll Lock state when activating

When this option is checked, AccuTerm remembers and restores the state of the CAPS LOCK and
SCROLL LOCK keys when the program is activated. Each session maintains its own independent state
for these keys. Note: this option is often unreliable - we are investigating a resolution for this.

Allow mouse input for supported applications

This option determines whether host mouse reporting is enabled. When this option is enabled (the
default), AccuTerm will enter mouse input mode when the host sends the enable mouse input
command.

Connection Settings

Connection Method

The Connection Method group of option buttons is used to select a connection type. Once a
connection type has been selected, other configuration options will become available. For example, if
Serial Port is chosen, various options for a serial port, such as port number, baud rate, etc. will be
displayed. The specific settings for each connection type will be described later in related topics.

Echo (duplex)

There are three echo options: remote echo (full duplex), local echo (half duplex) and loopback (local
mode). Typical terminal sessions operate in full duplex. In this mode, all characters typed on the
keyboard are sent to the host computer. They are not printed on the screen. The host echoes the
character back to the terminal where it is displayed on the screen. Usually, when control characters (
ENTER, BACKSPACE, DELETE, etc.) or function keys are sent to the host, the echo is suppressed and the
application responds in an appropriate manner. In half duplex mode, characters typed on the keyboard
are simultaneously sent to the host computer and displayed on the screen. In loopback mode,
characters are displayed directly on the screen and are not sent to the host computer. This mode is
usually used only for testing keyboard or display functions.

Clear high bit of received data

Most communications devices use eight bits to represent each character. When using eight bits, the
computer can send up to 256 different character codes. Some terminal types have no way of handling
characters abowve 127 (hex 7F). In this case, you can check this box and the high bit of each byte will be
automatically stripped from all received characters. If you need to use any international characters or
special symbols from the PC character set, you should not use this option (the Wyse 60 and VT
emulations have commands to access these characters when using only 7 bits).

Enable device licensing (U2 / QM / D3)

If this option is set, multiple connections (sessions) to compatible versions of UniData, UniVerse, QM
and D3 consume only a single user license. When the Append LF option is checked, the response
sent to the host by AccuTerm is terminated by a line-feed character. Contact your U2, QM or D3 dealer
for more information regarding device licensing. Note: Windows versions of U2 implement device
licensing using a proprietary Telnet server. This precludes using SSH with device licensing on these
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platforms.

Display connection warnings
Check this option to display non-fatal connection errors, such as UART overrun errors when using a
serial port connection.

Close session on disconnect
When this option is checked, if a connection is closed by the host computer the AccuTerm session will
automatically close. This option may be used in conjunction with the Close AccuTerm after last

session is closed option (General Options).

See also:

Telnet Settings
Secure Shell Settings
Serial Port Settings
Modem Settings

1.6.2.1 Device Settings:Telnet

AccuTerm supports Telnet connections to host machines over a TCP/IP network. Any Telnet server
(host) on the network, including hosts on the Internet, can be accessed.

Host name or IP address

Enter the host name or IP address in this field. If the desired host name has been used previously when
configuring a Telnet session, you may select it from the drop-down list by clicking the drop-down arrow
in this field.

Host type

If your host is listed in the Host Type list, select it, otherwise just use the Default host type. By
selecting a host type from this list, certain advanced options are configured to be compatible with the
specified host type. For some host types, the port number and host terminal type are also adjusted.

Port
If the Port field is left blank, or set to "Default" AccuTerm will use TCP port 23 (the default port for
Telnet). If a different port is used for Telnet connections to your host, enter that port number in this field.

Certain host systems, such as Raining Data D3, allow a host process number (PIB) to be mapped to a
specific TCP port number. You can use the Port setting to specify the port number mapped to your
process number. Consult with your system administrator for this setting.

Connect timeout
When establishing a connection to a host computer, AccuTerm will wait up to the specified number of
seconds before giving up. If this field is left blank, or zero, the default timeout is 15 seconds.

Note: this timeout only affects the time AccuTerm waits for a response from the host when opening a
connection to the host.

Advanced Options
Check the Show advanced options check-box to display the advanced Telnet options.

Binary
Normally, Telnet operates in "text mode", with special rules for handling CR and LF characters. When
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the Binary option is selected, Telnet sends CR and LF characters without any alteration. Some hosts do
not function correctly in binary mode.

Keepalive

Although the Telnet protocol specification does not provide for "keepalives", AccuTerm can send periodic
commands that should be ignored by most Telnet servers. Using keepalives may prevent the host (or
router) from detecting that the connection is idle and forcing a disconnect. To use keepalives, select
either DMARK or NOP as the command to send as a keepalive. Enter the desired interval in the every...
sec field.

Break key

Normally, AccuTerm sends the Telnet "interrupt process" command when you press the CTRL+BREAK
key. If your host requires a different BREAK command, or to use a control character instead of a
command, select the desired option from this drop-down list. If you select "control character”, enter the
decimal value of the control character to send in the code field (for CTRL+C, the decimal value is 3).

Skip initial option negotiation

When a Telnet connection is first established the AccuTerm and the host negotiate various operating
modes. When this option is selected, the initial option negotiation is suppressed. This is necessary for
some Telnet servers which do not respond correctly to Telnet options (Advanced Pick and D3 turnkey or
nailed Telnet).

Disable outbound coalescing

Normally, TCP delays outbound messages for a short time so that multiple small messages may be
combined into a single network packet. This prevents many small packets from clogging up the network.
When this option is selected, messages are sent as soon as possible. This may improve throughput
(especially when running GUI programs or performing file transfers), at the expense of increased network
traffic.

Allow internationalized domain names

Select this option to enable Internationalized Domain Names (IDN) for the host name. IDN relies upon a
standardized mechanism known as "Punycode" for encoding Unicode domain names using only the
ASCII characters that are permitted by the global DNS system.

Device Settings: SSH

AccuTerm supports Secure Shell (SSH) connections to host machines over a TCP/IP network
connection. Any SSH server on the network, including hosts on the Internet, can be accessed.
AccuTerm implements both version 1 and version 2 of the Secure Shell protocol. Protocol selection is
usually automatic and uses version 2 if it is supported by the host. Otherwise, it automatically falls back
to version 1.

AccuTerm Secure Shell requires Windows 128 bit encryption. You can check your encryption
capabilities by opening Internet Explorer and selecting "About Internet Explorer" from the Help menu. If
the Cipher Strength is less than 128 bits you will need to either upgrade to Internet Explorer 6 (or abowe),
or install the High Encryption Pack for your version of Internet Explorer. Search Microsoft's site for "High
Encryption" for more information.

Host name or IP address

Enter the host name or IP address in this field. If the desired host name has been used previously when
configuring a Telnet session, you may select it from the drop-down list by clicking the drop-down arrow
in this field.
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Host type

If your host is listed in the Host Type list, select it, otherwise just use the Default host type. By
selecting a host type from this list, certain advanced options are configured to be compatible with the
specified host type. For some host types, the port number and host terminal type are also adjusted.

Port
If the Port field is left blank, or set to "Default" AccuTerm will use TCP port 22 (the default port for SSH).
If a different port is used for SSH on your host, enter that port number in this field.

Connect Timeout
When establishing a connection to a host computer, AccuTerm will wait up to the specified number of
seconds before giving up. If this field is left blank, or zero, the default timeout is 15 seconds.

SSH version

Select the version of the SSH protocol that will be used by the connection. When you select "auto",
AccuTerm will automatically select the highest version supported by the host. If you select SSH1 or
SSH2, AccuTerm will only connect using the selected protocol. If the host does not support the selected
protocol, the connection will fail and an error message will be displayed.

Authentication

Select the authentication method which will be use to validate the user with the host. AccuTerm
supports "password", "interactive" and "public key" authentication. It is important to select an
authentication method that is compatible with the SSH server running on your host.

Private key

If "public key" authentication has been selected, click the Select... button to open the Key Management
dialog. Use the Key Management dialog to create new keys, load existing keys and import keys created
on another system.

Advanced Options
Check the Show advanced options check-box to display the advanced Telnet options.

Preferred cipher

If you wish to select the cipher used to encrypt the SSH session, you can select it from this list. If
"auto" is selected, the default cipher is used. Otherwise, you can choose Triple DES, Blowfish, 128 bit
AES or 256 bit AES. The default cipher for SSH1 is Triple DES. The default cipher for SSH2 is 128 bit
AES in CTR mode (aes128-ctr).

Only use preferred cipher

When this option is set, the cipher selected above must be supported by the host. If the preferred cipher
is not supported by the host, the connection will be terminated and an error message displayed. When
this option is not set, if the preferred cipher is not supported by the host, a different, mutually supported,
cipher (normally, Triple DES) will be used.

Break key

Normally, AccuTerm sends CTRL+C when you press the CTRL+BREAK key. Alternatively, you can opt to
send the BREAK command or INT signal when the CTRL+BREAK key is pressed. In order to use the
BREAK command, the SSH sener on your host must implement the Session Channel Break Extension
spec (RFC 4335). In order to use the INT signal, the SSH server must implement signals, and must
respond to the INT signal by interrupting or breaking the process. Not all SSH seners implement these
features. To use a control character instead of a command or signal, select "control character" from this
drop-down list and enter the decimal value of the control character to send in the code field.
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Send keepalives

When the Send keepalives option is selected, AccuTerm sends a dummy message to the host
periodically. This may prevent the host (or router) from detecting that the connection is idle and forcing a
disconnect. Enter the desired intenal in the every...sec field.

Disable outbound coalescing (advanced option)

Normally, TCP delays outbound messages for a short time so that multiple small messages may be
combined into a single network packet. This prevents many small packets from clogging up the network.
When this option is selected, messages are sent as soon as possible. This may improve throughput
(especially when running GUI programs or performing file transfers), at the expense of increased network
traffic.

Allow internationalized domain names

Select this option to enable Internationalized Domain Names (IDN) for the host name. IDN relies upon a
standardized mechanism known as "Punycode" for encoding Unicode domain names using only the
ASCII characters that are permitted by the global DNS system.

Key Management

Use the Key Management dialog to create public/private keys for SSH, or to load or import private
keys. AccuTerm supports RSA public keys for both SSH 1 and 2, and DSA public keys for SSH 2.
AccuTerm can import SSH 2 private keys that were created by OpenSSH or putty (puttygen). AccuTerm
can save public/private key files in either OpenSSH (www.openssh.org) or putty format.

Creating a new key

Click the Create New Key button to create a new public/private key pair. After clicking the Create New
Key button, select the key type (RSA or DSA), and key length. The default length of 1024 bits is
recommended. Enter a descriptive comment describing the key being created, and enter a password to
protect your private key. Although the password is optional, it is highly recommended since anyone who
gains access to your private key file can impersonate your identity! The Save Key button will remain
disabled until the password has been confirmed.

Click the Save Key File button to create the new key and save the newly created key file. By default,
AccuTerm will save the key in its standard key folder, located in the user's profile. You can select a
different location, such as a removable USB drive, if desired.

Once your public/private key pair has been created, you need to place the public key on the senver
which you want to connect to. Use the Export Key or Copy Key to Clipboard functions to retrieve your
public key so that it can be installed on the sener.

Exporting the key

You can save the public key to a file by clicking the Export Key button and selecting the Public Key
option. Click the Export button to save the public key file. Browse to the folder where you want to store
the public key file and click the Save button. Once saved, you could attach the key to an email
message and send it to the sener's administrator (it is a public key, so security is not a major issue).
You could also save the public key file to a removable drive or diskette and deliver it to the senver
administrator.

The same process can be used to export the private key file. Note: exporting the private key may pose a
security risk. If an unauthorized user obtains your private key he can impersonate you and gain access
to the host system using your identity! Use caution when making a copy of your private key.
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Copying the key to the clipboard

Click the Copy Key to Clipboard button to copy either the public key (recommended) or private key
(not recommended) to the clipboard. The process is the same as described under Exporting the key
except that you do not need to supply a destination file.

Loading an existing key

If your private key was saved to a different folder or to a removable drive or diskette, you can click the
Load Existing Key button to load that key. Enter the password and click the Verify button to check the
password. If the password is correct, the key fingerprint will be displayed. Click OK to use this key (in
its current location). Otherwise, you can save the key in a different location by clicking the Save Key
button.

Importing a key
Importing a key is exactly like loading an existing key, except for the file locations. AccuTerm can
import private keys created by OpenSSH.

Key fingerprint

When you create a new key, or load or import an existing key, AccuTerm displays the "fingerprint" of the
public key. You can use this fingerprint to ensure that your key is correct. Use a utility on the senver to
show the fingerprint of the public key and compare to the fingerprint shown in AccuTerm.

OpenSSH example
If the host is using OpenSSH as the SSH sener, and if you currently have access to the sener via
password authentication, you can set up public key authentication using the following steps:

1. Open an AccuTerm session and connect to the sener. Log in using your password.

2. Open the AccuTerm Settings dialog to create your new key pair. Select "public key" as the
authentication method.

3. Click the Select Key button to open the Key Management dialog.

4. Click the Create New Key button and follow the steps abowe for creating a new key.

5. Click the Copy Key to Clipboard button and choose the Public Key option. Click the Copy button.
6. Click OK two times to dismiss the dialogs. Ignore the warning about changes not being effective.

7. From a Unix/Linux prompt, change to your ~/ . ssh directory. Edit the aut hori zed_keys2 file using
your favorite text editor. Start a new line in the aut hori zed_keys?2 file.

8. From the AccuTerm Edit menu, choose Paste to paste the public key into the aut hori zed_keys2
file.

9. Sawe the modified aut hori zed_keys?2 file.

10. Sawe the modified AccuTerm session file. Close AccuTerm. Open AccuTerm and open the session
file you just modified.

11. Enter your user ID.

12. If you entered a password when you created your new key, you will prompted to enter the password.
Enter the password (case sensitive).

13. If the server accepts your key, you will be logged in.

1.6.2.3 Device Settings: SSL/Telnet

AccuTerm 7 supports SSL/Telnet connections to host machines over a TCP/IP network connection.
This connection method is used primarily for hosts running on Windows which do not normally support
Secure Shell. This connection method establishes a secure connection using industry-standard SSL/
TLS, then initiates a telnet session within the secure connection (tunnel). UniVerse and UniData
platforms running under Windows have built-in support for this connection method. Other platforms may
use an SSL proxy such as stunnel to support this connection method.
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Many of the SSL/Telnet settings are shared with the normal Telnet settings. Please refer to the Telnet
settings for details. Only the settings specific to SSL/Telnet are described in this topic.

Host name or IP address

Enter the host name or IP address in this field. If the desired host name has been used previously when
configuring an SSL/Telnet session, you may select it from the drop-down list by clicking the drop-down
arrow in this field. Note: depending on how you configure Server Validation, the value in this field may
need to match the Common Name attribute of the host's certificate.

Host type

If your host is listed in the Host Type list, select it, otherwise just use the Default host type. By
selecting a host type from this list, certain advanced options are configured to be compatible with the
specified host type. For some host types, the port number and host terminal type are also adjusted.

Port
If the Port field is left blank, or set to "Default" AccuTerm will use TCP port 992 (the default port for SSL/
Telnet). If a different port is used for SSL/Telnet connections to your host, enter that port number in this
field.

Connect timeout
When establishing a connection to a host computer, AccuTerm will wait up to the specified number of
seconds before giving up. If this field is left blank, or zero, the default timeout is 15 seconds.

Note: this timeout only affects the time AccuTerm waits for a response from the host when opening a
connection to the host.

Advanced Options
Check the Show advanced options check-box to display the advanced SSL and Telnet options.

Server Validation
When establishing an SSL/TLS connection, the host will send its server certificate to AccuTerm, so that
AccuTerm can authenticate the host's identity. AccuTerm supports a variety of validation options:
None: any server certificate is assumed to be valid.
Minimal: the senver certificate must not have been revoked. The certificate's name, role, expiration
and root certificate authority are ignored.
Self-signed - disregard host name: the sener certificate must not be expired and must not be
revoked. The certificate's name, role and root certificate authority are ignored.
Self-signed - verify host name: the sener certificate's Common Name must match the value in the
"Host name or IP Address" field (above). The certificate must not be expired or revoked. The
certificate's role and root certificate authority are ignored.
Strict - the server certificate must be issued by a trusted certificate authority, and it must be valid for
use as a Server certificate. It must not be expired or rewoked, and the Common Name must match
the value in the "Host Name or IP Address" field (above).
Custom - click the Custom button to customize the validation options.

Client certificate

The Client certificate is used for client authentication when establishing an SSL/TLS connection. Client
certificates are not normally used. If the senver requires a client certificate, select the desired certificate
from the drop-down list. Only certificates installed in the Windows Certificate Store are shown in this
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list. Note: for UniVerse and UniData, the "peer names" are not case-sensitive.

Advanced Telnet Options
See this topic for a description of the advanced Telnet options.

1.6.2.4 Device Settings: Serial Port

Port

AccuTerm supports serial ports from COM1 to COM127, at baud rates up to 115,000 baud. Although
you can select any port from 1 to 127, most computers only have one or two ports installed, and some
may not have any. The drop-down list contains all of the ports that AccuTerm was able to identify on
your computer.

Baud rate

Baud rate is the speed that the serial port communicates with the host computer. AccuTerm supports
baud rates from 300 to 115,000 baud. If your PC is connected directly to the host machine, you will
most likely use 9600 or 19200 baud. The speed that you use depends on the host computer. If you
select the wrong baud rate, you screen may appear garbled or you may get no response from the host
when you type on the keyboard.

Data bits
This refers to the number of bits the serial port sends to represent the actual character. The options are
7 or 8 bits (the default is 8 bits). This setting must match your host system.

Stop bits
This is the number of bits that the serial port uses to separate each character sent. The options are 1 or
2 stop bits (default is 1). This setting must match your host system.

Parity

Parity is an error checking mechanism performed by the serial port. The options are: None, Odd, Even,
Mark and Space. The most common is None (this is the default). This setting must match your host
system.

Flow control (handshake)

Computers can send information very quickly. Howewer, there are situations where one computer can
send data faster than the other computer can process it. In these cases, the computer on the receiving
end needs to inform the sending computer to suspend transmission until the slower computer is able to
catch up. A technique called “handshaking” is used to accomplish this task.

AccuTerm supports three methods of handshaking. The first and most common is. Xon/Xoff (or software
handshake). With this method, AccuTerm sends a special Xoff character (DC3) to the host system when
it wants the host to stop sending characters. When the AccuTerm has caught up, it sends the Xon
character (DC1). AccuTerm normally uses “inbound” Xon/Xoff handshake; that is, AccuTerm can control
flow of data from the host, but the host cannot control the flow of data from AccuTerm. If you check the
“bidirectional” option, then AccuTerm will use both “inbound” and “outbound” Xon/Xoff handshake allowing
the host to control the flow of data from AccuTerm as well.

The second handshake method supported by AccuTerm is DTR/DSR. This method is referred to as
hardware handshake because it physically changes the wltages on the serial port to indicate whether
the receiving computer is ready.
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The third method, RTS/CTS, protocol works the same as DTR/DSR except it uses a different pair of
signals (pins) on the serial port.

For DTR/DSR or RTS/CTS handshake to work, the cable which connects the PC and the host computer
must connect the appropriate handshake signals at both ends. Physical cable wiring is beyond the
scope of this reference.

This setting must match your host system.

Break key

Normally, AccuTerm sends a BREAK signal when you press the CTRL+BREAK key. Alternatively, you can
use a control character instead of the BREAK signal. If you select "control character”, enter the decimal
value of the control character to send in the code field (for CTRL+C, the decimal value is 3).

Device Settings: Modem

AccuTerm supports dial-up connections using modems which have been installed on your system.
AccuTerm uses TAPI (a senice built into Windows for supporting telephony) to communicate with your
modem. By using TAPI, AccuTerm can share the modem with other TAPI enabled applications, like
Windows fax applications.

Modem Name
To use a modem connection, select a modem from the Modem Name list.

Auto Answer
If you want AccuTerm to answer incoming calls, check the "Auto Answer" option.

Dialing Options
To modify the dialing properties for the selected modem, such as your current location, dialing prefixes,
etc., click the "Dialing Options" button.

Override settings from Control Panel

When this option not selected, the modem settings (baud rate, data bits, stop bits, parity and
handshake) are determined by the modem properties set in Control Panel (Phone and Modem Options).
Select this option to owerride the Control Panel settings.

Baud rate

Baud rate is the speed that the serial port communicates with the host or modem. AccuTerm supports
baud rates from 300 to 115,000 baud. If your PC is connected directly to the host machine, you will
most likely use 9600 or 19200 baud. The speed that you use depends on the host computer.

Only connect at this speed
Select this option to lock the modem speed to the selected baud rate. When this option is not selected
the specified baud rate is the maximum connection speed. Note: not all modems support this option.

Data bits
This refers to the number of bits the serial port sends to represent the actual character. The options are
7 or 8 hits (the default is 8 bits). This setting must match your host system.

Stop bits
This is the number of bits that the serial port uses to separate each character sent. The options are 1 or
2 stop bits (default is 1). This setting must match your host system.
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Parity

Parity is an error checking mechanism performed by the serial port. The options are: None, Odd, Even,
Mark and Space. The most common is None (this is the default). This setting must match your host
system.

Flow control (handshake)
AccuTerm supports two methods of handshaking for modem connections: software (Xon/Xoff) or
hardware (RTS/CTS). Most modern modems work best with hardware (RTS/CTS) handshake.

Break key

Normally, AccuTerm sends a BREAK signal when you press the CTRL+BREAK key. Alternatively, you can
use a control character instead of the BREAK signal. If you select "control character”, enter the decimal
value of the control character to send in the code field (for CTRL+C, the decimal value is 3).

1.6.3 Terminal Settings

Terminal Emulation

In order for AccuTerm to work properly with terminal-based applications, the terminal type that AccuTerm
is emulating must match the terminal type the host application is configured or designed to use. Select
the terminal type (emulation or personality) from the drop-down list. If you select the wrong type, your
screen will probably be scrambled, and you should try a different type. The following terminal types are
supported by AccuTerm 7:

Wyse 50: emulates a Wyse 50 terminal with “Enhanced” enabled. Wyse 50 emulation may also be
used for Wyse 30, 99, 125 and 350 terminals.

Wyse 60: emulates a Wyse 60 terminal with “Enhanced” enabled. Wyse 60 emulation is similar to
Wyse 50, but with non-embedded visual attributes (the visual attribute codes do not take a position
on the screen). Wyse 60 emulation may also be used for Wyse 150, 160 and 320 terminals.

ADDS Viewpoint A2: emulates the ADDS Viewpoint A2 terminal. This is the original A2 terminal,
with no enhancements.

ADDS Viewpoint 60: emulates the ADDS Viewpoint 60 terminal. The Viewpoint 60 is similar to the
A2, but uses embedded visual attributes (the visual attribute codes take a position on the screen).

Procomm VP60: emulates an ADDS Viewpoint 60 terminal, but with non-embedded visual
attributes. This emulation is similar to the Viewpoint 60 emulation provided by Procomm.

Viewpoint A2 Enhanced: emulates a Wyse 50 terminal in ADDS Viewpoint mode with “Enhanced”
enabled. This is basically a hybrid of Wyse 50 and ADDS Viewpoint A2. Viewpoint A2 Enhanced
may also be used for ADDS 2020 and 4000, and NCR 2900 terminals.

MDIS P30 (Prism): emulates a McDonnell Douglas Prism P30 terminal.
VT52: emulates the DEC VT52 terminal.

VT100: emulates the DEC VT100 terminal. VT100 is a 7-bit emulation, and can also be used for
applications which require VT102 terminals.

VT220: emulates the DEC VT220 terminal. The VT220 emulation supports a super-set of the VT100
commands, and includes a host-writable status line, protected characters, multiple character sets
and multiple pages.

VT320: emulates the DEC VT320 terminal. The VT320 emulation supports a super-set of the VT220
commands, and includes support for reporting and restoring various terminal states.
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VT420: emulates the DEC VT420 terminal. The VT420 emulation supports a super-set of the VT320
commands, and includes support for rectangle operations, left & right margins, and horizontal split
screen.

ANSI BBS: emulates the old MS-DOS ANSIL.SYS device driver. This emulation may be useful when
connecting to bulletin board systems.

Linux Console: emulates the Linux console, including function keys and colors.
SCO Console: emulates the SCO Unix console.

Pick PC Monitor: emulates the original Pick PC Monitor (“nm non” or “| ” terminal type), including
color and function keys.

Tektronix 4014: emulates the Tektronix 4010/4014 terminals. Color enhancements as implemented
in the CIT467 terminal (from CIE Electronics) are included.

Tektronix 4100: partially emulates the Tektronix 41xx terminals.

TTY Emulation: emulates basic TTY functions.

Host terminal type

When a Telnet or Secure Shell session is initiated, the contents of the Host terminal type field is
passed to the host. The host may use this information to set its TERM environment variable or setting.
Generally, when you change the Terminal emulation setting, the Host terminal type is automatically
updated. The two fields are similar, but normally are not identical. The Host type setting (Telnet or

Secure Shell) may influence the Host terminal type setting.

Answerback

The contents of this field are sent to the host when the application sends a "send answerback"
command to AccuTerm. Wyse and VT emulations support the answerback command. When the
answerback message is sent to the host under Wyse emulation, an ACK control character follows the
message. Under VT emulation, no terminator is sent.

Control characters may be entered into the Answerback field by prefixing the character with a caret (*).

Terminal Options
Certain terminal types support additional settings shown in the Terminal Options panel.

Send 8 bit controls

If this option is selected, then 8-bit control codes will be transmitted to the host. If the option is not set
(the default), equivalent 7-bit escape sequences will be transmitted to the host. This option applies to the
VT220, VT320, VT420 and Linux Console emulations.

Allow application mode

When this option is selected (the default), commands that switch the numeric keypad keys and cursor
keys into "application mode" are emulated. When the option is not selected, those commands are
ignored, preventing the terminal from switching to "application mode". This option is useful when the host
or application erroneously sends the command to enter application mode, and the application is
expecting normal numeric or cursor keys. This option applies to the VT emulations (except VT52) and
Linux Console emulation.

Keypad sends application codes
When this option is selected, the numeric keypad keys send special application codes. When the
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option is not set (the default), the numeric keypad keys send decimal humbers. This option applies to
the VT emulations (except VT52) and Linux Console emulation.

Cursor keys send application codes

When this option is selected, the cursor keys send special application codes. When the option is not
set (the default), the cursor keys send normal cursor codes. This option applies to the VT emulations
(except VT52) and Linux Console emulation.

Backspace key sends DEL

When this option is selected, the BACKSPACE key sends the DEL (delete) control code. When the option is
not set (the default), the BACKSPACE key sends the BS (backspace) control code. This option applies to
the VT emulations (except VT52) and Linux Console emulation.

Auto-print works just like VT terminal

When this option is selected, the "auto print" slave printer function works the same as a real VT
terminal. That is, when AccuTerm is in "auto print" mode, the entire screen line that the cursor is on is
printed when AccuTerm receives a CR, LF or FF control code. If this option is not set, then text is printed
as it is received from the host (similar to Wyse auto-print mode).

1.6.3.1 Screen Settings

Use the Screen Settings panel to specify the size of the terminal screen, the number of screen pages,
the number of history rows, the status line and other options.

Screen Size

There are two separate screen sizes that AccuTerm supports: normal and extended. These sizes are
used to emulate the 80 and 132 column modes of the Wyse and VT terminals. AccuTerm has taken the
extended and normal modes one step further: with AccuTerm you can define both the normal and
extended modes to be any number of columns or rows (up to a maximum of 240). You can select which
screen size is active when the session is first opened by checking the Active box for the desired size.

You will probably leave these settings at their default settings of 80 columns by 24 rows for normal mode
and 132 columns by 24 rows in extended mode. If you have software that supports other screen sizes,
you can experiment with these settings until you find a size that you like.

The number of rows may change if you change terminal emulations. The console terminal emulations
use 25 rows with no status line; others use 24 rows with one or more status lines.

When AccuTerm switches between the normal and extended modes, one of two things will happen:
either the font will change size to fit the visible screen, or scroll bars will be displayed if the full screen
will not fit within the session window at the selected font size (see Eonts).

Screen pages
Some of the terminals which AccuTerm emulates support multiple addressable pages. With AccuTerm,
you can have up to 25 pages.

History rows

AccuTerm supports a "history" or "scrollback" buffer, which saves lines which have scrolled off of the
terminal screen. To use this feature, specify how many rows (up to 10,000) are to be saved. When the
history buffer has been enabled (by setting the number of rows), use the vertical scroll bar, mouse wheel,
or keyboard commands to scan history.
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1.6.3.1.1

You can use CTRL+SHIFT+PGUP, CTRL+SHIFT+PGDN, CTRL+SHIFT+UP, CTRL+SHIFT+DOWN, CTRL+SHIFT+HOME, and
CTRL+SHIFT+END to scan the history.

Status & message lines

Some of the terminals that AccuTerm can emulate display status, function key labels or host messages
on the top or bottom lines of the screen. Depending on the terminal emulation selected, you may be able
to adjust the number of status lines to use.

For Wyse and ADDS emulations, up to 3 status lines are available: a host message line at the top of the
screen, and a "shifted" label line and "unshifted" label line at the bottom of the screen. For VT
emulations, only a single status line is available for displaying a message from the host at the bottom of
the screen. For the console emulations, the status line is not supported.

No message or status line: select if you do not want any status or message lines.

Shared message & status line: select to use a single, shared line at the bottom of the screen. If
the native terminal supports more than one line (Wyse and ADDS Viewpoint), the bottom row of the
screen displays the most recently used line. The line is shared between label line, shifted label line
and host message line.

Split message & status lines: select if you want two separate status lines. The host message line
is the top row of the screen display, and the label line is displayed on the bottom row. If the shifted
label line is programmed, pressing the SHIFT key displays the shifted label line. Releasing the SHIFT
key displays the unshifted label line.

Separate message, status & shift lines: select if you want three separate status lines. The host
message line is the top row of the screen display, and the shifted and unshifted label lines are
displayed on the bottom two rows.

Show scrollbar

Select this option if you would like a vertical scroll bar at the right edge of the screen window. The
vertical scroll bar is useful when scanning history, or if the window is too small to display the complete
screen.

Allow Tektronix graphics

Checking this box enables the Tektronix 4010/4014/4100 graphic terminal emulation. If the Tektronix
graphics mode is enabled, AccuTerm will automatically switch to the Tektronix graphic emulation when
it receives the appropriate command from the host computer. AccuTerm will return to the previous
emulation mode when graphics mode is terminated.

Automatic line wrap

When this option is checked, automatic line-wrap is enabled. When the cursor reaches the end of a line,
typing another character normally causes the cursor to mowve to the beginning of the next line. When this
option is not set, the cursor does not move.

Cursor style
AccuTerm supports either a blinking block or blinking underscore for the terminal screen cursor.

Protected attribute
Wyse 50 and Wyse 60 terminals use a visual attribute to identify "protected" characters. To change the
"protected” attribute, click the drop-down arrow and select the desired attribute.

Color Settings

Most of the terminals which AccuTerm emulates do not support color. Instead, they hawe visual
attributes like normal, reverse, dim, blink, underline, etc. While AccuTerm supports these visual
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attributes, it also supports color, even for terminals without native color support. This is done by
assigning a foreground (text) and background color to each of the visual attributes that the native
terminal supports.

Preview

The Preview window displays a sample screen with commonly used attributes using the current color
settings. To choose a different color for any attribute in the preview window, click on the name of the
attribute you would like to change. A drop-down list showing all possible color combinations will be
displayed. Click an item in the list to change the foreground and background color of the attribute.

Theme

The Theme buttons provide an easy way to select one of the built-in color themes. Themes consist of
the palette colors and attribute colors. To preview any of the built-in themes, hover the mouse over one of
the theme buttons. The Preview panel temporarily changes to the theme under the mouse so you can
see the effect without actually changing the current settings. To select one of the built-in themes, click
the theme's button.

The built-in themes are:

Default colors: uses a palette of 8 dark and 8 light colors. The dark colors are a bit darker than the
dark legacy colors and the light colors are a bit lighter. The "normal" color (this is the color that the
screen displays any time it is cleared) is light gray with black text.

Legacy colors: uses a palette of 8 dark and 8 light colors. The palette is essentially the same as
the original VGA palette. This is the palette that all prior versions of AccuTerm have used. The
"normal” color is dark blue with yellow text.

White on Black: resets the palette to the 16 default palette colors and assigns combinations of
black, light gray, dark gray and black to each of the visual attributes. The normal color is black with
light gray text.

Black on White: similar to White on Black, except that the normal color is light gray with black
text.

Green Screen: resets the palette to the default palette, except that the Olive color is a medium
shade of green. Assigns combinations of light green, medium green, dark green and black to each
of the visual attributes. The normal color is black with medium green text.

Reverse Green Screen: similar to Green Screen, except that the normal color is medium green
with black text.

System colors: sets sewveral colors in the palette to "system colors" defined in the Windows Display
Properties. The normal background color is "Window background" and the normal text color is
"Window text." The following palette colors are replaced by a system color:

Black = Window Text Color

White = Window Background Color
Dark Blue = Highlight Background Color
Olive = Highlight Text Color

Light Gray = 3D Light

Dark Gray = 3D Shadow
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Other palette colors are set the same as the default colors.

Advanced Colors & Styles
Click this button to open the Attribute Colors panel, which allows you to fine-tune the colors for each
visual attribute.

See also:
Palette Settings

1.6.3.1.1.1 Attribute Colors

The mapping of visual attributes to colors is displayed as a table with an entry for each possible attribute
combination. Select an item from the attribute table to modify or view its properties. Each item has a
background color and text color. Sample text using the selected colors is shown in the attribute table

Attribute effects

Since AccuTerm assigns colors to the visual attributes, some of the visual effects are not as important
as they were on a real terminal. You can disable the underline effect or the blinking effect is you like.
The assigned colors will still be used for those attributes, but the actual underline or blink will be
disabled.

See also:
Palette Settings

1.6.3.1.1.2 Palette Settings

1.6.3.2

AccuTerm uses a palette of 16 colors for the background and foreground (text) color of all characters on
the screen.

The drop-down list for each of the palette entries displays a list of the 16 standard VGA colors, the
system colors (from Windows Display Properties), and a final item called "Custom Color". Click on any
item in the list to select that item, or click on Custom Color to open a color selection dialog where you
can choose any shade you like for the palette entry.

Since it is possible for the application to request specific foreground and background colors, it is
recommended that the color chosen for a particular palette entry is close to the color name associated
with that entry.

Note: selecting a theme on the Colors & Themes panel will replace all of the palette entries with colors
compatible with the selected theme.

Keyboard Settings

The Keyboard Settings panel is specify keyboard options and open the keyboard programming window.

Locking programmed keys
Most terminals provide commands that allow the host to program the function keys. If you would like
the host to be able to reset and reprogram the keys, select the Unlocked — host can reset or
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reprogram keys option. If you would like the host to be able reprogram keys, but not reset them to
their default values, select the Locked — host cannot reset keys to defaults option. If you would like
to prevent the host from resetting or reprogramming keys, select the Locked — host cannot reset or
reprogram keys option.

Map F11 through F20 to CTRL+F1 through CTRL+F10
Some terminals (like Wyse 50 and 60) have more than 12 function keys on their native keyboard.
Since the PC keyboard only has 12 function keys, AccuTerm allows you to map the native F11
through F20 keys to PC keyboard CTRL+F1 through CTRL+F10 (and native SHIFT+F11 to
SHIFT+F20 to PC CTRL+SHIFT+F1 through CTRL+SHIFT+ F10).

Note: for Wyse, the last native key is F16; for the VT terminals, the last native key if F20; for all
others,the last native key is F12. In the preceding paragraph, replace F20 with the last native key for
the terminal being emulated.

Start with Caps Lock on
Sometimes applications are designed for upper-case text. If you would like the CAPS LOCK key
state to be "on" when the session is opened, check this option.

Program the Keyboard
Click this button to open the keyboard programming window.

1.6.3.2.1 Keyboard Programming

The Keyboard Editor is used to manually program the keyboard. For real terminals, this is usually
limited to the function keys F1 to F12. However, AccuTerm supports programming almost any key on
the keyboard.

Click on key to edit (also Shift, Ctrl and Alt modifiers)
Esc F1|F2|F3| F4| F5| F6| F7|F3 F3 | F10| F11|F12| pemi| scd| Pau
1] 2 3 E|6|(7 (8|9 |0-|-= Back ins homgpgugl NUM [/ | | -
Tab | Q| W|E|R|T| Y| U[I | O [ |1 \ ded | end | pgdn 7|8 (39
+
CAPS | A S| D|F|G|H|Jd|K|L Enter 4| 5| 6
SHIFT | Z | X | C |V |B|N|M ! SHIFT t 11|12 3
CTRL AT Space ALT CTRL P 0
Selected key: Clshit Do O at [ Reset to defauit...
Key data:
Button bar key caption:
Button bar help hint: [ fo's ] l Cancel ]

Click on any key to view or edit the programming for that key. The programmed contents of the selected
key is copied to the Key data field, and the key's name is shown in the Selected key field. The state of
the Shift, Ctrl and Alt keys reflected by the corresponding check boxes. Clicking the SHIFT, CTRL, or
ALT keys on the keyboard editor toggles their state. The new state is reflected in the check boxes.
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1.6.3.3

Key data

If the content of the selected key is the default for that key, the Key data field is shown using nor nal
characters. If the content is not the default, it is shown in bol d. Control characters are shown with a
caret (™) prefix. You can enter most control characters by simply holding the CTRL key while typing the
corresponding alpha key. For example to enter CTRL-M, hold the CTRL key and press the M key. *M
will be added to the text in Key data field.

The carat (") and backslash (\) characters are used as special prefixes in keyboard programming. If you
need to enter either of these characters, just enter two of them (" or \\).

The keys can be programmed with a character sequence which is transmitted to the host when the key
is pressed.

Reset to default...

Clicking the Reset to default button opens a Reset Keys dialog where you can specify which keys you
want to reset: the current key, the normal (A-Z, 0-9, etc.) keys, cursor keys, function keys, function key
captions or the entire keyboard. If any option except "current key" is selected, you can restrict the reset
to the current key bank. In this case, only the keys with the same Shift, Ctrl and Alt state are reset.
Click the Reset button to perform the action or Cancel to return to the Keyboard Editor.

Font Settings

Font

The Font drop-down list shows all of the available fonts installed on your computer that are suitable for
use with AccuTerm. In order for a font to be considered suitable, it must be fixed-pitch (most Windows
fonts are not fixed-pitch), and it must support the ANSI character set. AccuTerm uses the open-source
DejaVu Sans Mono font by default.

The AccuTerm Legacy and AccuTerm Legacy (bitmap) fonts are also available in case you prefer
those instead. Due to limitations of bitmap fonts in Windows, the AccuTerm Legacy (bitmap) font is
limited to the Latin-1 character set (ISO 8859-1) and does not contain the all of the symbol characters.

Size
The Size list shows the font sizes available for the selected font. Choose "auto” if you want the font to
scale to fit the screen size. This is the default.

Style
Select either "normal” or "bold" font style.

Keep legible
If this option is checked, and the Size is set to "auto”, AccuTerm will never scale a font smaller than 5
pixels wide by 7 pixels high.

Character set

Select the character set encoding that is used by the application running on the host. Most terminals
have one or more native character sets - these are always included in the character set encoding list and
are the most common choice. The current Windows ANSI character set is also included in the character
set list. Select this encoding if your host application is using the same ANSI character set that Windows
is using. If your application uses Unicode sends and receives data using UTF-8, select the Unicode
(UTF-8) encoding. Other single-byte character sets that are installed in Windows may be also be
selected.
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For VT220, 320 & 420 emulations, the selected character set is used when AccuTerm receives the SCS
(select character set) command to select the UPSS (user-preferred supplemental set).

You should select a font that supports all the characters used by your application. Windows includes a
feature known as "Font Linking" which enables the use characters (actually, glyphs) from a similar font if
a required glyph is missing from the selected font. This sometimes yields poor results, so selection of
an appropriate font is important.

Euro character

If your host application needs to display the Euro currency symbol, enter the ASCII value of the Euro
symbol, as used on your system. Note: for most character sets there is no standard value for this
symbol. Some possible values are 128 (Windows ANSI), 164 (Latin-1 currency and Latin-9 Euro) and
213 (IBM modified code page 850). Unicode (UTF-8) defines the Euro as U+20AC. If you are using
Unicode encoding, the Euro character value is ignored.

1.6.3.4 Sound Settings

Terminal bell

Like the margin bell of antique mechanical typewriters, terminals have the ability to "ring a bell", usually
to get the attention of the operator. The ASCII BEL control code is universally used to "beep" the terminal.
AccuTerm 7 Lite provides two choices for the sound generated by this command.

Enable terminal bell sound
By default, the "bell" sound is enabled. If your environment requires a silent terminal, you can disable the
sound by un-checking this box.

Play Windows default sound
AccuTerm will play the wawe file assigned to Windows “Default Beep” program event defined in the
Sounds applet in Control Panel. Click the Test button to play the sound immediately.

Beep using PC speaker
To use a real "beep" as the "bell" sound, select this option.

1.6.4 Printer Settings

AccuTerm 7 uses the printer in two ways: First, AccuTerm can print the contents of the terminal screen
(Screen Print). The user can perform a Screen Print by using Eile » Print Screen from the main menu,

by clicking the eg button on the toolbar or by using the keyboard shortcut ALT+G. The application on
the host can also send a command to AccuTerm to print the screen.

The other way AccuTerm uses the printer is as a "slave printer". Most of the terminals that AccuTerm
emulates allowed the user to attach a printer to a special port on the terminal. This printer was known as
a "slave printer", which was accessed by the application program differently than a "system printer". The
port that the slave printer was attached to was often called an "auxiliary port", so "slave printer" is
synonymous with "auxiliary printer" or "aux printer".

AccuTerm can direct data that it receives from the host to the Slave Printer either by receiving the
appropriate command from the application or by using File » Printer On from the main menu. The
ALT+P keyboard shortcut can also be used to toggle the state of AccuTerm's Slave Printer. A panel in
AccuTerm's status bar indicates the current state of the Slave Printer.
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AccuTerm can print in two modes: text and graphics. Text is the mode used by “real” terminals. This
mode is different from normal Windows printing in that the Windows “printer driver” is not used. For
screen printing, text mode sends the screen text to the printer. For slave printing, AccuTerm passes raw
data, including control characters and escape sequences from the host directly to the printer (or
spooler). In text mode, the host computer is responsible for setting printer font sizes and page
orientation by sending the appropriate printer commands.

In graphics mode, AccuTerm prints an image of the screen on the printer, using the Windows printer
driver. When the screen is printed in graphics mode, the printed image includes text, line drawing
characters, and may optionally include the screen background and colors. For slave printing, AccuTerm
understands CR (carriage return), LF (line feed) and FF (form feed) control characters, but other control
characters and escape sequences are ignored. You can select the font, paper size and page orientation
used for slave printing in graphics mode. You can select the paper size and orientation used for screen
print in graphics mode.

AccuTerm 7 has separate printer configurations for screen and slave printing. Both configurations contain
similar settings which are described in this topic.

Enable printing
Enable or disable slave or screen printing by checking or un-checking this box.

Printer selection

Select the printer to use for slave or screen printing from the Printer drop-down list. The first item in the
list is always the current default Windows printer. Select this item to use the Windows default printer for
slave or screen printing. Even though the name of the current default printer is shown here, selecting this
option will track changes to the default printer. If a specific printer is desired, select it from the drop-down
list.

Text mode

Select text mode if you want to send raw text to the printer. For slave printing, the print data can contain
control codes and escape sequences to control the printer. For screen printing, the screen text is sent
to the printer with CR LF after each line.

Eject page before / after (text mode only)
Selecting either of these options causes a page eject before or after each print operation. These options
are only available in text mode. Graphics mode always ejects a page after the print operation.

Graphics mode

Graphics mode is normally used for screen printing since the printed output closely resembles the
actual screen, including the font used on the screen. Graphics mode may be necessary for slave printing
if the selected printer cannot use text mode. Many printers now only support graphics mode.

Page Setup (graphics mode only)
Click this button to select the font, paper size and orientation used for screen or slave printing in
graphics mode.

Print background (screen print only)
Select this option to print the screen background when printing the screen in graphics mode.

Print in color (screen print only)
Select this option to print the screen in color. If the Print background option is also checked, then the
screen background is also printed in color.
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Printer job close timeout (slave printer only)

Enter the number of seconds to wait after receiving a Printer Off command before closing the print job.
Usually, when the host computer needs to print a report, it sends a Printer On command, sends the
printer data and then sends a Printer Off command. But some host programs send a Printer On
command, send some data to the printer, send a Printer Off command, and send some other data to the
screen, and then send another Printer On command, and send more data to the printer, etc. Because of
this, AccuTerm has no way of knowing when the host is finished sending the print job. The only way it
can determine this is to wait for a set amount of time after the Printer Off command before closing the
job. If this field is set to the default of 5 seconds, AccuTerm waits 5 seconds after the Printer Off
command has been received before closing the print job.

This causes a delay when printing under AccuTerm. If all your host programs always turn the slave port
on, send all the data and then turn it off, you can reduce this number to 1 or 0. If you have programs that
are constantly turning the slave port on and off, you may need to adjust this number until things work
correctly.

1.6.5 Clipboard Settings

Paste Options: end-of-line
When the clipboard is "pasted” to an AccuTerm session, AccuTerm transmits the clipboard text to the
host computer. The end of line options determine what AccuTerm does at the end of each line: send
CR (default), send LF, send CF+LF, send TAB, do nothing, or send a user-defined character. To specify a
user-defined character, select the user defined option and enter the ASCIl code of the character to be
sent at the end of each line.

If you do not want the end-of-line character to be sent after the last (or only) line pasted, check the Do
not send line-end after last (or only) line pasted option.

Paste Options: end-of-text

After pasting the clipboard to an AccuTerm session, AccuTerm can send an optional end of text
character. Normally, AccuTerm does not transmit any character at this time, but you can select EOF
(which is the SuB or CTRL+Z control code), or send a user-defined character. To specify a user-defined
character, select the user defined option and enter the ASCII code of the character to be sent at the
end of a paste operation.

Interline delay

After each line from the clipboard is sent to the host computer, AccuTerm will wait for the specified delay
time before sending the next line. The delay time is specified in milliseconds. Note: this is the same
delay setting as the ASCII file transfer.

Copy Options: Clear selection after copy

Normally, if there is a selection rectangle shown on the AccuTerm screen, copying the selection to the
clipboard leaves the selection intact after copying. Check this option if you would like to automatically
remove the selection from the screen after copying it to the clipboard.

Copy / Paste shortcut
AccuTerm supports standard Copy and Paste functions using the Edit menu or the context (right-
click) popup menu. You can also choose shortcut keys for these functions: CTRL+INS / SHIFT+INS or
CTRL+C / CTRL+V. However, if you select the shortcut you will no longer be able to use the normal
function of the shortcut keys. For example, if you select CTRL+C / CTRL+V for your Copy / Paste
shortcut, you will not be able to send the CTRL+C control character anymore.

Copyright © 2010-2014 Zumasys, Inc.



38

AccuTerm 7 Lite Help

Copyright © 2010-2014 Zumasys, Inc.



Welcome to AccuTerm 7 Lite

1.7 Contacting Zumasys

Zumasys customer senice department may be reached by phone, fax, email or the web.

Zumasys, Inc.

9245 Research Drive
Inine, CA 92618
USA

Phone:
Fax:
Email:
Web:

1 (866) 986-2797
1 (949) 334-0288

accuterm@zumasys.com

WWw.Zzumasys.com
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2.1

AccuTerm 7 Reference

AccuTerm Programming

AccuTerm 7 supports many "private” commands which may be sent by host application programs.
These commands are valid in all terminal types.

ESC STX O

ESCSTX 1

ESC STX 2

Mouse Functions

Disable mouse input; turns off mouse cursor.

Enable mouse input; turns on mouse cursor. Transmits mouse location whenever a mouse
button is pressed. Both single and double clicks are supported. A single-click will always
precede a double-click. Note: this command is ignored unless host mouse reporting is
enabled in the General Settings.

The format of the mouse click report depends on whether the current terminal type uses
ASCIl or ANSI-style function keys. The report is designed to look like a function key,
followed by the click position. For terminal types with ASCII-style function keys, the report
is:

STXb CR ccc. rr CR

where b indicates which mouse button was pressed (p=left click, gq=right click, r = center
click, P=left double click, Q=right double click, R=center double click), ccc is the three digit
column of the mouse cursor and rr is the two digit row of the mouse cursor (both in
decimal, 000. 00 is the upper left corner).

For terminal types with ANSI-style function keys, the report is:
ESC[ n ~ESC[r; c R

where n indicates which mouse button was pressed (101=left click, 102=right click, 103
=center click, 111=left double click, 112=right double click, 113=center double click), r is
the row of the mouse cursor and c is the column of the mouse cursor (both in decimal,
where 1;1 is the upper left corner). If the terminal is using 8-bit control codes, AccuTerm
sends €SI instead of ESC [ . in this report.

Note: if the mouse is clicked on an image that is displayed on the terminal screen, the

location in the above reports is replaced by the image file name.

SystemBuilder compatibility mode; turns on mouse cursor. Transmits mouse location
whenever a mouse button is pressed. Note: this command is ignored unless host mouse
reporting is enabled in the General Settings.

STX~CR b; c; rcCR
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b indicates which mouse button was pressed (1 = left, 2 = right, 4 = center), c is the
column of the mouse cursor and r is the row of the mouse cursor (both in decimal, 0;0 is
the upper left corner).

Status and Control

ESC STX |
Returns AccuTerm release, serial number, type and licensee information. Message format
is:
ACCUTERM W N rel serial type licensee... CR
where rel is the AccuTerm release number, serial is the program serial number, type is
SI NGLE, SI TE, CORP, DEALER or DEMO, and licensee is the name under which the program
has been licensed.
ESC STX ?

Returns a string indicating the platform, product type, license type, capabilities and
automation senices. Message format is:

platform * product * license * capabilities * services CR

where platform is 3 (Win32); product is 4 = AccuTerm (standard version), 5 = AccuTerm
Internet Edition, 6 = AccuTerm Emulator ActiveX Control, 7 = AccuTerm Lite; release
number, serial is the program serial number, license is 1 = single user, 2 = site, 3 =
enterprise, 5 = deweloper, 7 = internet, 8 = component, 9 = evaluation; capabilities is a
string of letters indicating the various capabilities where:

A = ASCII protocol supported

B = Border effects (visual styles) enabled
C = Capture supported

D = Download supported

E = Execute command supported

F = On-the-fly character set conversion supported during file transfers
G = GUI supported

H = Server mode supported

| = Image display supported

J = Screen sawe & restore supported

K = Kermit protocol supported

L = Background image supported

O = Object Bridge supported

P = Packetized messages supported

Q = Message integrity checks supported
R = Reliable connection

S = Scripting supported

T = File transfer error info supported

U = Upload supported

V = Host capabilities command supported
X = File conversion supported

Y = Printer control & status query supported

services is a string of letters indicating which automation senices are available (a = Object
Bridge, b = file conwerter, g = GUI).
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ESC STX = host-capabilities * buffer-size CR
Informs AccuTerm of any special host program capabilities. host-capabilities is a string of
letters indicating various host features:

D = host programs use tag notation for system delimiters
C = host supports message checksums
M = host supports message length check

buffer-size is optional, and specifies the maximum packet size that the client can send to
host.

ESC STX % O
Returns the program directory, followed by CR. This is normally the directory where
AccuTerm is installed, except in the case of AccuTerm Internet Edition, the directory
returned is the one containing the Internet Explorer exe file.

ESC STX % 1
Returns the current directory (usually from the shortcut "start in" field), followed by CR.

ESC STX % 2
Returns the directory containing AccuTerm's atwin71.ini file, followed by CR.

ESC STX % 3
Returns the directory containing AccuTerm's emulator DLL, followed by CR.

ESC STX X
Terminates the current AccuTerm session. If only one session exists, then AccuTerm is
terminated also.

ESC STX W
Sawes the current session settings to disk. If no session file name exists, then one will be
prompted for.

ESC STX L
Sets the CapsLock key state to "On"

ESC STX M

Sets the CapsLock key state to "Off"

Terminal Screen

ESC STX E
Selects extended (132 column) screen size as defined by the extended columns and rows
in the screen settings.

ESC STX N
Selects normal (80 column) screen size as defined by the normal columns and rows in the
screen settings.

ESC STX Acolor CR
Sets the foreground (text) color to color. This command overrides the foreground color
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ESC STX Bco

ESC STX r x1

assigned by the last visual attribute selected.

lor CR
Sets the background color to color. This command owerrides the background color assigned
by the last visual attribute selected.

Black
Dark Blue
Dark Green
Turgoise
Dark Red
Purple
Olive
Light Gray
Dark Grey
Blue
Green
Cyan

Red
Magenta
Yellow
White

© 00N O~ WwWwN PP o

[ g o Y
g h~w N RO

Note: the actual display color may vary from the color shown in the table, since it is
possible to modify the palette (see Color Settings).

,yl, x2, y2, fill, border CR
Draw rectangle. x1,y1 is the upper-left corner and x2, y2 is the lower-right corner.
Coordinates are in character columns and rows. The upper-left corner of the screen is (0,0).

The rectangle can be filled using either a visual attribute or a background color. To fill with a
visual attribute, fill is AO .. A63. The attribute number is formed by adding the following

values:
0 = normal
1 = invisible
2 = blinking
4 = reverse
8 = underline
16 = dim
32 = bright

To fill with a background color (as described abowe), fill is BO ... B15. AccuTerm 7 Lite does
not support borders - specify N (no border).

ESC STX j S,ID,col,row ,width , height , page CR

Sawves a copy of the specified screen block (text, colors and visual effects) and terminal
state in memory and associates the block with the specified identifier (ID) which can be an
arbitrary alpha-numeric string (may not contain commas). Any number of screen blocks can
be saved. Col and row specify the upper-left corner of the block. If either is omitted or null,
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zero is assumed. Width and height specify the size of the block. If width or height is omitted
or null, the screen width or height is used. Page optionally specifies the terminal page for
the block, and if omitted or null, the current page is used.

ESC STX jR,ID,col,row , page, state CR
Restores the screen block associated with the specified identifier (ID) to the screen. Col and
row specify the upper-left corner of the destination. If either is omitted or null, the original
position of the saved block is assumed. Page optionally specifies the terminal page for the
destination, and if omitted or null, the current page is used. State optionally specifies
whether the terminal state (cursor position, visual attribute, text color, etc.) is restored To
restore the terminal state, pass 1 for this argument.

ESC STX jD,ID CR
Deletes the screen block associated with the specified identifier (ID) from memory.

ESC STX yj, IDCR
Queries status of a stored screen block. Sends a 0 or 1, followed by a CR, indicating if a
block of the specified identifier (ID) exists in AccuTerm's screen block memory.

Keyboard

ESC STX Fts dk data CR
Program function and keypad keys. Type t may be N (normal function keys), C (control
function keys), A (ALT function keys) or K (keypad keys). Both C and K are permitted when
programming control-keypad keys. Shift s may be U (unshifted) or S (shifted). Destination d
must be null. Key code k may be digits 0to 9 or: ; < => according to the following table.
Data contains the function key data (or caption text). Normally, the key data is transmitted
to the host when the programmed key is pressed. Howe\er, if data is enclosed in brackets
([ 1), then when the key is pressed, the key data will be interpreted as a VBA script
statement and will be executed instead of being sent to the host.

Key Function |[Editing
Code key key

0 F1 BKSP

1 F2 TAB

2 F3 INS

3 F4 DEL

4 F5 HOME

5 F6 END

6 F7 PGUP

7 F8 PGDN

8 F9 LEFT

9 F10 RIGHT

: F11 up

; F12 DOWN

< ESC

= ENTER
> KPD ENTER

To enter control characters (and special prefix characters) in key data, use the notation
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shown in the following table:

Key Control AccuTerm Key Control  |/AccuTerm
seguence code notation seguence code notation
CTRL + @ NUL @ CTRL+P DLE AP

CTRL + A SOH A CTRL +Q DC1 "Q

CTRL +B STX "B CTRL +R DC2 "R
CTRL+C ETX "C CTRL+S DC3 "S

CTRL +D EOT D CTRL+T DC4 T

CTRL +E ENQ ~E CTRL + U NAK U

CTRL +F ACK F CTRL +V SYN "V
CTRL+G BEL G CTRL +W ETB W
CTRL +H BS ~H CTRL + X CAN X

CTRL + 1 HT M CTRL +Y EM Y

CTRL +J LF ~J CTRL +Z SUB nNZ

CTRL + K VT K CTRL +[ ESC A

CTRL +L FF AL CTRL +\ FS A\

CTRL + M CR M CTRL +] GS o

CTRL + N SO N CTRL +~ RS N~

CTRL +O SI ~O CTRL + _ us "

N AN \ \ \
DELETE DEL n7?

For example, to program the END key to send the word "END", followed by a carriage return,
the following code could be used:

EQU ESC TO CHAR(27), STX TO CHAR(2), CR TO CHAR(13)
PR NT ESC: STX: ' FKUSEND'M : CR

Printer

ESC STX p mode CR
Selects the printer mode:
mode = 0 - turns off auto or transparent print
mode = 1 - turns on auto (copy) print mode
mode = 2 - turns on transparent print mode
mode = X - turns off auto or transparent print and closes the print job immediately
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2.2

Wyse Programming
This topic describes the command sequences for programming the Wyse 50, Wyse 60 and ADDS

Viewpoint Enhanced terminal emulations. These three emulations use a common command set with
a few differences. The differences are noted.

Operating Modes

ESC " n
Set mode n. This command is used to set many of the terminal's operating modes. The
mode values and their function are shown in the Wyse Operating Mode Table.

ESC B

Places terminal in local mode.

ESC C or ESC D F
Places terminal in full duplex mode.

ESC DH
Places terminal in half duplex mode.

ESC N
Disables auto scrolling. Normally if the cursor is moved down below the last line, the
screen is scrolled up one line. If auto scrolling is disabled, the cursor mowes to the top line
and no scrolling takes place.

ESC O

Enables auto scrolling.

ESC X or ESC u
Turns the monitor mode off.

ESC U
Turns the monitor mode on.

ESC k
Turns the local edit submode on. This command is not supported by AccuTerm and is
ignored.Jr

ESC |
Turns the local edit submode off. This command is not supported by AccuTerm and is
ignored.

ESC q
Turns the insert mode on. In this mode, all characters sent to the screen are inserted into
the line with any existing characters moved one column to the right.

ESC r
Turns the insert mode off.

ESC # or Sl
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Lock keyboard.'r

ESC 5 or EOT
Lock keyboard.i

ESC " or SO
Unlock keyboard. T

ESC 6 or STX
Unlock keyboard. *

GS
If the graphics mode is enabled, this command puts the terminal in the Tektronix emulation
mode. If the graphics mode is disabled, this command is ignored.
ESC 1 ESC FF
If the graphics mode is enabled, this command puts the terminal in the Tektronix emulation
mode. If graphics mode is disabled, it sets a tab stop at the current cursor column.
ESC %! O
Enters Tektronix 4100 graphics mode.
CAN
Exits from the Tektronix graphics emulation mode.
CAN
Turns on the cursor. T
ETB
Turns off the cursor.i
ESC 2

Exits from the Tektronix graphics emulation mode. If the terminal is not in the graphics
emulation mode, it clears any tab stops at the current cursor column.

ESC Fmessage CR
Displays a message in the host message line. The message string can be up to 46
characters in 80 column mode and 98 characters in the 132 column mode.

ESC c ; message EM
Programs the answerback message (up to 30 characters).

ESC c <
Sends the answerback message to the host, followed by ACK. If no answerback message
has been programmed, simply sends ACK.

ESCc =
Erases the answerback message.

EsC d /

End of line wrap on. When the cursor reaches the end of a line, it will wrap to the beginning
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of the next line.
ESC d .
End of line wrap off. When the cursor reaches the end of a line, it does not wrap to the
beginning of the next line.
ESCe &
Set CapsLock keyboard state.
ESCe '
Clear CapsLock keyboard state.
ESCe .
Do not clear screen when screen size changes.
ESCe /
Clear screen when screen size changes.
ESC™ O
Normal display (light characters, dark background).
ESC™ 1
Rewerse display (dark characters, light background).
ESC ~ SPACE
Enhance mode off. If the current emulation is ADDS VPAZ2E, then the emulation will
change to ADDS VPAZ2.
ESC ~ !
Enhance mode on. If the current emulation is ADDS VPA2, then the emulation will change
to ADDS VPAZ2E.
ESC ~
Select Wyse 50 emulation.
ESC ~ %
Select ADDS VPA2E emulation.
ESC ~ 4
Select Wyse 60 emulation.
ESC ~ 6
Select VT-52 emulation.
ESC ~ 8
Select Viewpoint 60 emulation.
ESC ~
Select VT-100 emulation.
ESC ~ <

Select VT-220 7-bit emulation.
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ESC ~ = or ESC ~ A
Select VT-220 8-bit emulation.

ESC ~ B

Select VT-320 7-bit emulation.
ESC ~ C

Select VT-320 8-bit emulation.
ESC ~ >

Select Tektronix 4014 emulation.

ESC c V or ESC c W
Sawve current session settings to disk. If no session file name exists, then one will be
prompted for.

ESC c X
Reset (reload session configuration file).

Character Set Selection

Wyse terminals have two character sets (primary and secondary) of 128 symbols each, and four font
banks of 128 symbols. Each font bank can be assigned a pre-defined symbol set (like PC Multinational),
and each character set can be assigned to one font bank.

By default, the native Wyse 50 symbol set is assigned to font banks 0, 2 and 3. The PC Multinational
symbol set is assigned to font bank 1. Font bank 0 is assigned to the primary character set and font
bank 1 is assigned to the secondary character set.

ESC c D
Selects the primary character set. This is the default, and when selected, the primary
character set is displayed for character codes 0 to 127, and the secondary character set is
displayed for codes 128 to 255.

ESC c E
Selects the secondary character set. When the secondary character set is selected, it is
displayed for character codes 0 to 127 and again for codes 128 to 255.

ESC c¢ B bank
Assigns font bank bank (0, 1, 2 or 3) to the primary character set.

ESC c¢ C bank

Assigns font bank bank (0, 1, 2 or 3) to the secondary character set.

ESC ¢ @bank set
Assigns pre-defined symbol set set to font bank bank. Set can be one of the following:

set symbol set
@or * Native Wyse 50
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set symbol set

Aora PC Multinational
B,c,d,G,Horg US ASCII

J,j,N,l ore DEC Graphics / ISO Latin-1
Dorb PC Standard

Cursor Positioning

FF

ACK

BS

NAK

HT or ESC i

ESC |

LF

SuB

ESC j

CR

us

DEL

Cursor right. If the cursor is on the last column of the line, the cursor will wrap to the next
line, possibly scrolling the screen up.'r

Cursor right. If the cursor is on the last column of the line, the cursor will wrap to the next
line, possibly scrolling the screen up.i

Cursor left. If the cursor is at the beginning of the line, it is moved up to the last column of
the previous line. If the cursor is at the home position, it is moved to the lower right hand
corner of the screen.

Cursor left. Same as the BS command.I
Mowes the cursor to the next programmed tab stop. For this command to work, tab stops
must be programmed with the ESC 1 command.

Mowe the cursor left to the previous tab stop.

Cursor down. If the cursor is on the last line of the screen and the "no scroll" mode is
turned off, the screen will scroll up one line. Otherwise, the cursor will move to the top line
of the screen.

Cursor up. If the cursor is at the top row, it is moved to the bottom row.Jr

Cursor up. Ifthe cursor is at the top row, it is moved to the bottom row.i
Cursor up. Ifthe cursor is at the top row, the screen is scrolled down.
Mowes the cursor to the first column (column zero) of the current row.

Mowes the cursor down one row and owver to the first column (column zero).
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Ignored.

RS or ESC {
Mowes the cursor to the home position (upper left corner of the screen).

VTr
Mowves cursor to row r, where r is a valid row code from the Viewpoint Cursor Address Table.
iy

DLE c
Mowes the cursor to column ¢ where c is a valid column in the from the Viewpoint Cursor
Address Table. ¥

ESC =rcC
Mowes the cursor to row r and column c. r and c are single byte cursor address codes from
the Wyse Cursor Address Table. Note that this command cannot position the cursor past
column 95.

ESC Y rc

Mowes the cursor to row r and column c where r and ¢ are single byte cursor address codes
from the Wyse Cursor Address Table. Note that this command cannot position the cursor

past column 95.¢

ESC arr Rccc C
Moves the cursor to row rr and column ccc. rr is the two digit decimal number of the row
(from row 1 at the top). ccc is the three digit decimal number of the column (from column 1
at the left). Note that this command can address the entire 132 column screen.

ESC _c
Mowes the cursor to column ¢ where ¢ is a single byte column address from the Wyse
Cursor Address Table. Note that this command cannot position the cursor past column 95.
T

ESC [ r
Mowes the cursor to row r where r is a single byte row address from the Wyse Cursor
Address Table.

ESC ]
Selects page 0.

ESC }
Selects page 1.

ESC - nrc
Selects page n (pages numbered from 0) and positions the cursor to row r, column ¢. r and
¢ are single byte cursor address codes from the Wyse Cursor Address Table. To select
pages higher than 9, use CHAR(n +48).

ESC wn

Selects page n. Pages are numbered from 0 to 9.

Copyright © 2010-2014 Zumasys, Inc.



52

AccuTerm 7 Lite Help

ESC w C
Page forward. If currently on the last page, the first page is selected.
ESC K
Page forward. If currently on the last page, the first page is selected. T
ESC w B
Page back. If currently on the first page, the last available page is selected.
ESC J
Page back. If currently on the first page, the last available page is selected.
ESC w @nrc
Selects page n (pages numbered from 0) and positions the cursor to row r, column ¢. r and
¢ are single byte cursor address codes from the Wyse Cursor Address Table. To select
pages higher than 9, use CHAR(n +48).
ESC x Ar
Splits screen horizontally at row r, where r is a valid row code from the Wyse Cursor
Address Table or from the Viewpoint Cursor Address Table if in Viewpoint Enhanced mode.
ESCx 1r
Splits screen horizontally at row r and clear screen, where r is a valid row code from the
Wyse Cursor Address Table or from the Viewpoint Cursor Address Table if in Viewpoint
Enhanced mode.
ESCx @
Redefine screen as one window.
ESCx 0

Redefine screen as one window and clear screen.

Erasing and Editing

SOH
Clears the screen and returns the cursor to the home position (upper left corner of the
screen).i
FF
Clears the screen and returns the cursor to the home position (upper left corner of the
screen). Turns off the protected mode.I
SuB
Clears the screen and returns the cursor to the home position (upper left corner of the
screen). If the terminal is in "protect mode", only unprotected characters are cleared.t
Esc ;

Clears the screen and returns the cursor to the home position (upper left corner of the
screen). If the terminal is in "protect mode"”, only unprotected characters are cleared.
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ESC * or ESC +

Clears the screen and mowe the cursor to the home position (upper left corner of the
screen). Both protected and unprotected characters are cleared. Turns off the protect
mode.

ESC T or ESC t

ESC K

ESC Y

ESC y

ESC k

ESC ,

ESC E

ESC Q

ESC R

ESC W

ESCc Nwh

ESC c Grc

Clears from the cursor position to the end of the current line. If the terminal is in "protect
mode", only unprotected characters are cleared.

Clears from the cursor position to the end of the current Iine.i

Clears from the cursor position to the end of the screen. If the terminal is in "protect mode",

only unprotected characters are cleared.'r

Clears from the cursor position to the end of the screen. If the terminal is in "protect mode",
only unprotected characters are cleared.

Clears from the cursor position to the end of the screen. ¥

Clears the screen to protected spaces. Turns off the protect mode. "No scroll" mode is
turned off (auto scroll).

Insert line. A blank line is inserted before the current line. The current line and all lines
below are moved down one row. The bottom line of the screen is lost. The cursor is moved
to the left most column of the inserted line.

Insert character. A blank is inserted at the current cursor position. All characters from the
cursor position to the right are mowved right one column.

Delete line. The current line is deleted. All lines below the current line are moved up one
position. The bottom line is blank. The cursor is moved to the left most column.

Delete character. The character at the current cursor position is deleted. All characters to
the right of the cursor are mowved left one column and a blank is placed on the last column of
the line.

Box rectangle. Current cursor location is upper left, w and h specify rectangle width and
height.

Box rectangle. Current cursor location is one corner, r and ¢ specify row and column of
other corner.
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ESC ¢ Frcx
Clear unprotected rectangle. Cursor location is one corner, r and ¢ specify row and column
of other corner. Rectangle is cleared to character x.

ESC ¢ Hrcx
Clear entire rectangle. Cursor location is one corner, r and ¢ specify row and column of
other corner. Rectangle is cleared to character x.

ESCc " asp Prrl Rcccl Crr2 Rccc2 Cdp Prr3 Rccec3 C
Copy / swap / move rectangle. Action a is: 0 to swap, 1 to copy, 2 to move. Source page
sp, upper left corner rr1, cccl; lower right corner rr2, ccc2; destination page dp, upper left
corner rr3, ccc3. All parameters are decimal numbers. Columns and rows are humbered
from 1, pages are numbered from O.

Video Attributes

Video attributes work differently in the Wyse 50 or Viewpoint Enhanced emulations than they do in the
Wyse 60 emulation. Under Wyse 60, the attributes are non-embedded. In other words, they do not
take up a character position on the screen. Under Wyse 50 or Viewpoint Enhanced, the attribute takes
up a space and changes all following characters to the end of the screen or until another attribute
character is encountered.

Under Viewpoint Enhanced mode, a single non-embedded (takes up no space) "tagged" attribute may
be assigned and used. This "tagged" attribute is also the "protect" attribute.

AccuTerm's Viewpoint Enhanced emulation supports most ADDS 4000 functions, including support for
both non-embedded attributes like Wyse 60 and embedded attributes like Wyse 50.

ESC Oa
Assigns the "tagged" video attribute. a is the video attribute code from the Viewpoint
Attribute Code Table. ¥

SO
Start tagged attribute. All characters received after this code are displayed with the
currently assigned tagged attribute. If the tagged attribute is changed, the attribute of the
displayed characters also changes.i

Sl
End tagged attribute. All characters received after this code are displayed with the normal
video attribute.i

ESC Ana

Sets the video attribute for any of the four application display areas. n is the display field
code and a is the attribute code from the Wyse Attribute Code Table. The application
display field codes are:

Field (n) Display area

0 The main screen
1 The function key labeling line
2 The status line
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Field (n) Display area
3 The host message field

ESC Ga
Assign visual attribute. In Wyse 50 and ADDS VP mode, this command displays a space
at the cursor position, then changes the visual attribute for all characters from this position
until the end of the screen or until another attribute code is encountered. In Wyse 60 mode,
this command selects the attribute for characters displayed after this command. The visual
attribute is specified by the attribute code a from the Wyse Attribute Code Table.

ESC ga
Assign visual attribute. This command selects the attribute for characters displayed after
this command. The \isual attribute is specified by the attribute code a from the Wyse

Attribute Code Table. T

ESC Gn or ESC gn ¥
Assign line attribute. This is the same command as is used to assign visual attributes, but
with different attribute codes. This sequence is used to specify character size for the current
line. The line attribute code n is:

attribute

normal size characters

double-wide characters

double-high characters, top

double-high characters, bottom

double-wide, double-high characters, top
double-wide, double-high characters, bottom

moow>g >

ESCHT n

Assign line attribute (performs the same function as abowe using different attribute codes): +

attribute

normal size characters

double-wide characters

double-wide, double-high characters, top
double-wide, double-high characters, bottom

W NPk O S

Protected Attributes

Protected attributes are used by some software applications to protect characters from being
overwritten. If the terminal is running in its protected mode, the cursor cannot be positioned over
protected characters and all non-protected characters can be cleared by using the "clear unprotected"
command.

ESC &
Enable protect mode and set "no scroll" mode.
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ESC '

ESC

SO

ESC

SI

ESC !

ESC .

ESC

ESC

ESC

ESC

ESC

Disable protect mode and set "auto scroll".
)

Start protect mode. All characters sent after this sequence become protected characters
until the protect mode is turned off.

Start protect mode. ¥

Stop protect mode. All characters sent after this sequence are unprotected characters.

Stop protect mode.i

Writes all unprotected attributes with a specified attribute where a is a valid attribute code
from the Wyse Attribute Code Table.

Replaces all unprotected characters with the character c.
; Or ESC : or SUB

Clears all unprotected characters.

Clears the screen to protected spaces. The protect mode is turned off and the auto scroll
function is turned on.

Clears the entire cursor column to protected spaces.

cR or ESC cS
Clears unprotected characters from the cursor position to the end of the current line.
Attributes are not cleared.

cP or ESC cQ
Clears unprotected characters from the cursor position to the end of the screen. Attributes
are not cleared.

Line Graphics

ESC

ESC

Hg
Display a line graphic character at the current cursor position. The graphic character is
specified by graphic character code g from the Wyse Graphic Character Table. The line
graphics characters can be used for drawing simple boxes on the screen in text mode. It
should not be confused with the Tektronix graphic mode which is much more sophisticated
and capable of drawing pie charts, scientific diagrams, etc.

H STX
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Turn on line graphics mode. All characters received while the line graphics mode is on are
interpreted as graphics characters according to the Wyse Graphic Character Table.

ESC H ETX
Turn off line graphics mode.

Printer Control and Terminal Reports

ESC SPACE
Reports the terminal identification to the host computer. Sends 50 followed by a CR.

ESC ?
Transmits the cursor address to the host computer. The cursor address is transmitted in 80
column format, followed by a CR.

ESC /| or ESCw °
Transmits the page number and cursor address to the host computer. The cursor address
is transmitted in 80 column format, followed by a CR.

ESC 4
Sends unprotected characters in the current row to the host computer, from the beginning of
the row up to the cursor position. The row is terminated by a cr.t

ESC 5
Sends all unprotected characters on the screen to the host computer, beginning with the
upper-left corner, and ending at the cursor position. Each row except the last is terminated
by a us control code. The last row is terminated by a CR. T

ESC 6
Sends the current row to the host computer, from the beginning of the row, up to the cursor
position. The row is terminated by a CR. T

ESC 7

Sends the screen to the host computer, beginning with the upper-left corner, and ending at
the cursor position. Each row except the last is terminated by a Us control code. The last
row is terminated by a CR.

ESC L OrESC P or ESC p
Prints the entire screen to the printer port.

ESC M
Sends the character at the current cursor position to the host computer.
ESC S
Sends a message unprotected. This function is not supported by AccuTerm.
ESC b
Sends the current cursor address to the host computer in 132 column format. No CR is sent
after the address.
ESC s
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Sends a message. This function is not supported by AccuTerm.

DC2
Auto print mode. Characters are displayed and printed. This command will not function if
the printer selection is set to "No printer".

DC4
Cancel auto or transparent print mode. Note: This command will not turn the printer off if it
was turned on by the Viewpoint Enhanced transparent print or ANSI print commands.

CAN
Transparent print mode. Characters are printed, but not displayed.

ESC 3
Transparent print mode. Characters are printed, but not displayed.i

ESC 4
Cancel transparent print mode. *

ESC d #
Transparent print mode. Characters are printed, but not displayed.

ESC[ ? 5 i
Transparent print mode (ANSI). Characters are printed, but not displayed. When AccuTerm
receives this command, it goes into transparent print mode until it receives the ANSI print off
sequence below. This command is useful for printing graphics data to the printer. Since
AccuTerm requires the specific ANSI cancel command below to exit transparent print mode,
there is less chance of a control character interrupting the graphic printing.

ESC[ ? 4 i

Cancel transparent print mode (ANSI).

Programming Function Keys

The Wyse 50, Wyse 60 and Viewpoint Enhanced emulations support the ability to download function
key values from the host computer. The function key programming consists of two steps, downloading
the actual values which the key will send to the host whenever it is pressed or downloading a descriptive
function key label that is displayed on the function key labeling line.

When programming the function keys or function key labels, all characters (including control characters)
may be included in the sequence, except for the terminator (DEL for keys, CR for labels).

To clear a programmed function key or label, send the same command used for programming the key or
label, but omit the sequence.

ESC z k sequence DEL
Program function key k to send sequence to host when pressed. The function key codes
are specified in the Wyse Function Key Table.

ESC z flabel CR
Program function key label field f as label. The field codes are specified in the Wyse
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ESC

ESC

ESC

ESC _

ESC

ESC

ESC

ESC

Function Key Table.

Z 0k sequence DEL
Program function or keypad key k to send sequence to host when pressed. The function
and keypad key codes are specified in the Wyse Function Key Table.

z ( text CR
Sets the unshifted label line to text. If text is omitted, clears the unshifted label line.

Z ) text CR
Sets the shifted label line to text. If text is omitted, clears the shifted label line.

f label EM
Program function key label field f as label. The function key field codes are specified in the

Viewpoint Function Key Table. +

f textCR
Sets the unshifted label line to text. If text is omitted, clears the unshifted label line.

% k On sequence EM
Program function or keypad key k to send sequence to host when pressed. The function

and keypad key codes are specified in the Viewpoint Function Key Table. ¥

Clear all redefinable key definitions to their default values.

Z ~k
Read programmable key definition for key k.

221 Wyse Tables
2.2.1.1 Wyse Operating Mode Table

The Wyse Operating Mode Table defines the operating mode (n) used by the Wyse emulations to set
the terminal operating mode.

Function

Cursor off

Cursor on

Block cursor

Line cursor

Normal protect character
Rewerse protect character
Dim protect character
Screen off

Screen on

80 column screen

; 132 column screen
Protect blink on

C Protect invisible on

© 0N >IWwW NP O S
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2.2.1.2 Wyse Cursor Address Table

@O T m >

Function
Protect underline on

Protect reverse on

Protect dim on

The Wyse Cursor Address Table shows the character code used by the Wyse emulations to specify

cursor column (c) or row (r).

Row (r) or
column (c)

© 00N O Ok W DNk

W W WINDNINDNDNDNMNDNNNNRERPRERRPRPERERRERPRRPPRPRLPRE
NP, OO oNOO O~ WDNPEPOIOOWLWNOOOOPAMWINEO

Code

SPACE

O N O WN PO T

NV

Row (r) or
column (c)
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64

Code

>PTITITINKK X s <ICHOXTO DOoOZZIM| X~ T ITomMMmMmOoOo0 >

Row (r) or  Code
column (c)

65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96

I"“_""N‘<><§<C""U)"Q'OODB_X‘_'_'I(Q_"'('DQ_OO'QJ

DEL
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2.2.1.3 Wyse Attribute Code Table

The Wyse Attribute Code Table defines the attribute code character (a) used by the Wyse emulations
to assign visual attributes.

Code (a) Attribute Type

Normal

Invisible

Blink

Invisible

Rewerse

Reerse, invsible

Rewerse, blink

Reerse, invisible

Underline

Underline, Invisible

Underline, blink

Underline, blink, invisible
Underline, reverse

Underline, reverse, invisible
Underline, reverse, blink
Underline, reverse, blink, invisible
Dim

Dim, invisible

Dim, blink

Dim, invisible

Dim, rewverse

Dim, reverse, invsible

Dim, reverse, blink

Dim, reverse, blink, invisible
Dim, underline

Dim, underline, invisible

Dim, underline, blink

Dim, underline, blink, invisible
Dim, underline, reverse

Dim, underline, reverse, invisible
Dim, underline, reverse, blink
DEL Dim, underline, reverse, blink, blank

© 00N O U W NP O
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2.2.1.4 Wyse Function Key Table

The Wyse Function Key Table defines the key code character (k) used by the Wyse emulations to
program function and keypad keys. Also defines the field code character (f) used for programming
function key labels.
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Key

F1

F2

F3

F4

F5

F6

F7

F8

F9

F10
F11
F12
F13
F14
F15
F16
BKSP
TAB
INS
DEL
HOME
END
PGUP
PGDN
LEFT
RIGHT
upP
DOWN
ESC
ENTER
KPD ENTER

2.2.1.5 Wyse Key Code Table

Normal key | Shifted key

code (k)

OZZTrX«e - I@OTMmMOO®T>E

* U-IO

—

SPACE
$
S

code (k)

oCQ —Hh o o 6o T 9

— = [= -

Normal  Shifted
field () field ()

0

© 00N O O WN R

EE

NV

>— - T N<Xs<cH0nwDOT

The Wyse Key Code Table describes the default character sequence transmitted by the function,
keypad and other special keys on the PC keyboard and the corresponding real terminal key.

PC

Key

BKSP
SHIFT+BKSP
TAB
SHIFT+TAB
INS
SHIFT+INS
DEL

Terminal
Key

BKSP
SHIFT+BKSP
TAB
SHIFT+TAB
INS
SHIFT+INS
DEL

Sequence
BS

BS

HT

EsC |

ESC q
ESC r

Esc W
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PC Terminal

Key Key Sequence
SHIFT+DEL DEL LINE ESC R
HOME HOME RS
SHIFT+HOME SHIFT+HOME ESC {
END CLR LINE ESC T
SHIFT+END CLR SCRN ESC Y
PGUP PGUP ESC J
SHIFT+PGUP SHIFT+PGUP ESC J
PGDN PGDN ESC K
SHIFT+PGDN SHIFT+PGDN ESC K
LEFT LEFT BS
SHIFT+LEFT SHIFT+LEFT BS

RIGHT RIGHT FF
SHIFT+RIGHT SHIFT+RIGHT FF

up up 73
SHIFT+UP SHIFT+UP VT

DOWN DOWN LF
SHIFT+DOWN SHIFT+DOWN LF

ESC ESC ESC
SHIFT+ESC SHIFT+ESC ESC
ENTER RETURN CR
SHIFT+ENTER SHIFT+ENTER CR

KPD ENTER ENTER CR
SHIFT+KPD ENTER SHIFT+ENTER CR

F1 F1 SOH @CR
SHIFT+F1 SHIFT+F1 SOH ° CR
F2 F2 SOH A CR
SHIFT+F2 SHIFT+F2 SOH a CR
F3 F3 SOH B CR
SHIFT+F3 SHIFT+F3 SOH b CR
F4 F4 SOH C CR
SHIFT+F4 SHIFT+F4 SOH c CR
F5 F5 SOH D CR
SHIFT+F5 SHIFT+F5 SOH d CR
F6 F6 SOH E CR
SHIFT+F6 SHIFT+F6 SOH e CR
F7 F7 SOH F CR
SHIFT+F7 SHIFT+F7 SOH f CR
F8 F8 SOH G CR
SHIFT+F8 SHIFT+F8 SOH g CR
F9 F9 SOH H CR
SHIFT+F9 SHIFT+F9 SOH h CR
F10 F10 SOH | CR
SHIFT+F10 SHIFT+F10 SOH i CR
F11 F11 SOH J CR
SHIFT+F11 SHIFT+F11 SOH j CR
F12 F12 SOH K CR
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PC

Key
SHIFT+F12
CTRL+F1
SHIFT+CTRL+F1
CTRL+F2
SHIFT+CTRL+F2
CTRL+F3
SHIFT+CTRL+F3
CTRL+F4
SHIFT+CTRL+F4
CTRL+F5
SHIFT+CTRL+F5
CTRL+F6

2.2.1.6 Wyse Graphic Character Table

222

Terminal
Key
SHIFT+F12
F11
SHIFT+F11
F12
SHIFT+F12
F13
SHIFT+F13
F14
SHIFT+F14
F15
SHIFT+F15
F16

Sequence

SOH
SOH
SOH
SOH

SOH k
SOH L

SOH
SOH
SOH
SOH
SOH
SOH

k CR
J CR
i CR
K CR
CR
CR
| CR
M CR
m CR
N CR
n CR
O CR

The Wyse Graphic Character Table defines the character code used for each of the line-drawing
graphic characters used by the Wyse emulations.

Graphic

T
L

Z

Wyse Programming Notes

Code

0

1

Graphic

}
]

Code

T Functions tagged with the single-dagger symbol are only valid in Wyse 50 or Wyse 60 emulation.

¥ Functions tagged with the double-dagger symbol are only valid in Viewpoint Enhanced emulation.
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2.3 ADDS Programming

This topic describes the command sequences for programming the ADDS Viewpoint A2, Viewpoint 60
and Procomm VP60 terminal emulations. These emulations use a common command set with a few
differences. The differences are noted.

Operating Modes

EsC B
Status line off. o
ESC b
Status line on. <
ESC D
Screen display off.<>
EsC d
Screen display on.<>
ETB
Turns off the cursor.
CAN
Turns on the cursor.
GS
If the graphics mode is enabled, this command puts the terminal in the Tektronix emulation
mode. If the graphics mode is disabled, this command is ignored.
ESC %! O
Enters Tektronix 4100 graphics mode.
CAN

Exits from the Tektronix graphics emulation mode.

Cursor Paositioning

ACK
Cursor right. If the cursor is on the last column of the line, the cursor will wrap to the next
line, possibly scrolling the screen up.

BS or NAK
Cursor left. If the cursor is at the beginning of the line, it is moved up to the last column of
the previous line. If the cursor is at the home position, it is moved to the lower right hand
corner of the screen.

LF

Cursor down. If the cursor is on the last line of the screen and the "no scroll" mode is
turned off, the screen will scroll up one line. Otherwise, the cursor will move to the top line

Copyright © 2010-2014 Zumasys, Inc.



66

AccuTerm 7 Lite Help

SuB

CR

DLE c

ESC Yrc

of the screen.

Cursor up. Ifthe cursor is at the top row, it is moved to the bottom row.

Mowes the cursor to the first column (column zero) of the current row.

Mowes cursor to row r, where r is a valid row code from the Viewpoint Cursor Address Table.

Mowes the cursor to column ¢ where c is a valid column in the from the Viewpoint Cursor
Address Table.

Mowes the cursor to row r and column ¢ where r and ¢ are single byte cursor address codes
from the Wyse Cursor Address Table. Note that this command cannot position the cursor
past column 95.

Erasing and Editing

FF

ESC K

ESC k

ESC M

ESC F

ESC |

ESC E

Clears the screen and returns the cursor to the home position (upper left corner of the
screen). Turns off the protected mode.

Clears from the cursor position to the end of the current line.
Clears from the cursor position to the end of the screen.

Insert line. A blank line is inserted before the current line. The current line and all lines
below are moved down one row. The bottom line of the screen is lost. The cursor is moved

to the left most column of the inserted Iine.<>

Insert character. A blank is inserted at the current cursor position. All characters from the
&

cursor position to the right are moved right one column.

Delete line. The current line is deleted. All lines below the current line are moved up one

<

position. The bottom line is blank. The cursor is moved to the left most column.

Delete character. The character at the current cursor position is deleted. All characters to
the right of the cursor are mowed left one column and a blank is placed on the last column of

<

the line.
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Video Attributes

The Viewpoint A2, Viewpoint 60 and Procomm VP60 have different ways of programming video
attributes.

The ADDS Viewpoint A2 terminal supports video attributes through the use of "tagged" characters.
When a character is received from the host, it is either "tagged" or "normal". Tagged characters are
displayed with the currently assigned tagged video attribute. Only one attribute may be displayed on the
screen at one time - all characters which are "tagged" are displayed using the current tag attribute.
Other emulations, including Viewpoint A2 Enhanced and ADDS 4000, allow multiple attributes to be
displayed simultaneously.

Programming video attributes involves two separate steps. First, the tag attribute must be assigned.
Next, in order to display characters in the assigned tag attribute, a "start tag attribute" code must be
sent. To send characters in the normal attribute, an "end tag attribute" code must be sent. These two
steps are independent and can be executed in either order.

The ADDS Viewpoint 60 (and Procomm VP60) emulations use the same escape sequence as the
Viewpoint A2 but it is interpreted differently. Under ADDS Viewpoint 60 mode, the attribute takes up a
space and changes all following characters to the end of the screen or until another attribute character is
encountered. It works similar to the Wyse 50 video attributes. Under Procomm VP60, multiple visual
attributes may be displayed at the same time, but the attribute character does not use a space on the
screen, and does not affect any previously displayed characters. It works similar to the Wyse 60 video

attributes.

SO
Start tagged attribute. All characters received after this code are displayed with the
currently assigned tagged attribute. If the tagged attribute is changed, the attribute of the
displayed characters also changes.

Sl
End tagged attribute. All characters received after this code are displayed with the normal
video attribute.

ESC 0 a

ADDS Viewpoint A2: Assign visual attribute. This command sets the current visual
attribute. All characters which are “tagged” are displayed on this attribute. The attribute is
specified by the attribute code a from the Viewpoint Attribute Code Table.

ADDS Viewpoint 60: Assign visual attribute. This command is used to start a specific
attribute. This command changes all characters from the current position until the end of
the screen or until another attribute code character is encountered. The attribute uses a
screen position. The attribute is specified by the attribute code a from the Viewpoint
Attribute Code Table.

Procomm VP60: Assign visual attribute. This command is used to start a specific
attribute. The attribute does not use a screen position. All characters output after this
command are displayed in the specified attribute. The attribute code is specified by the
attribute code a from the Viewpoint Attribute Code Table.

Line Graphics
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231
2.3.11

ESC 1
Turn on line graphics mode. All characters received while the line graphics mode is on are
interpreted as graphics characters according to the Viewpoint 60 Graphic Character Table.
<

ESC 2

Turn off line graphics mode.<>

Printer Control

DC2
Auto (copy) print mode. Characters are displayed and printed. This command will be
ignored if the current slave printer selection is "None".

DC4
Cancel auto or transparent print mode. Note: This command will not turn the printer off if it
was turned on by the Viewpoint Enhanced transparent print or ANSI print commands.

ESC 3
Transparent print mode. Characters are printed, but not displayed.

ESC 4
Cancel transparent print mode.

ESC[ ? 5 i
Transparent print mode (ANSI). Characters are printed, but not displayed. When AccuTerm
receives this command, it goes into transparent print mode until it receives the ANSI print off
sequence below. This command is useful for printing graphics data to the printer. Since
AccuTerm requires the specific ANSI cancel command below to exit transparent print mode,
there is less chance of a control character interrupting the graphic printing.

ESC[ ? 4 i

Cancel transparent print mode (ANSI).

Viewpoint Tables
Viewpoint Cursor Address Table

The Viewpoint Cursor Address Table shows the character code used by the Viewpoint emulations to
specify cursor column (c) or row (r).

Column (c) |Code Column (c) Code Column (c) Code

1 NUL 36 5 71 p
2 SOH 37 6 72 q
3 STX 38 7 73 r
4 ETX 39 8 74 s
5 EOT 40 9 75 t
6 ENQ 41 @ 76 u
7 ACK 42 A 77 v
8 BEL 43 B 78 w
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Column (c) |Code

9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35

BS
HT
DLE
DC1
DC2
DC3
DC4
NAK
SYN
ETB
CAN
EM
SPACE

%

A WIN PFP O~/

2.3.1.2 Viewpoint Attribute Code Table

Column (c) Code Column (c) Code

44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70

79
80

© 00N O Ok WwN PP

T Tae o o0 o T <K Xss<CH0wXTOoOT T IOmmoOo
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RIWINPFP OO ~NOO O™ WNIRFRO

Row (r)

X
y

Code

s <CcHnWTO TOZZM X"Y T IOmMMOOT>E
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The Viewpoint Attribute Code Table defines the attribute code character (a) used by the Viewpoint
emulations to assign visual attributes.

Code (a) |Attribute Type

0w WO T O W E

o T 9

Normal

Dim

Normal Blinking

Dim Blinking
Rewerse

Dim Rewerse
Rewerse Blinking

Dim Rewerse Blinking
Underlined

Dim Underlined
Underlined Blinking
Dim Underline Blinking
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2.3.1.3 Viewpoint Function Key Table

Code (a) |Attribute Type

d

Invisible

The Viewpoint Function Key Table defines the key code character (k) used by the Viewpoint
emulations to program function and keypad keys.

Key
F1

F2

F3

F4

F5

F6

F7

F8

F9
F10
F11
F12
F13
F14
F15
F16
BKSP
TAB
INS
HOME
END
PGUP
PGDN
LEFT
RIGHT
UupP
DOWN
ESC
ENTER
KPD ENTER

2.3.1.4 Viewpoint Key Code Table

Normal key code (k)

NUL
SOH
STX
ETX
EOT
ENQ
ACK
BEL
BS
HT
LF
VT
FF
CR
S0
sl

Shifted key code (k)

DLE
DC1
DC2
DC3
DC4
NAK
SYN
ETB
CAN
EmM

SuB
ESC

C<X<ouemmw>»0@ " XsS$S39a

The Viewpoint Key Code Table describes the default character sequence transmitted by the function,
keypad and other special keys on the PC keyboard and the corresponding real terminal key.

PC Key
BKSP
SHIFT+BKSP

Terminal Key
BKSP
SHIFT+BKSP

Sequence

BS
BS
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PC Key Terminal Key Sequence
TAB TAB HT
SHIFT+TAB SHIFT+TAB Esc O
INS INS ESC q
SHIFT+INS SHIFT+INS ESC r
DEL DEL EsC W
SHIFT+DEL DEL LINE Esc |
HOME HOME SOH
SHIFT+HOME SHIFT+HOME SOH

END CLR LINE ESC K
SHIFT+END CLR SCRN ESC k
PGUP PGUP ESC J
SHIFT+PGUP SHIFT+PGUP ESC J
PGDN PGDN ESC |
SHIFT+PGDN SHIFT+PGDN ESC |
LEFT LEFT NAK
SHIFT+LEFT SHIFT+LEFT NAK
RIGHT RIGHT ACK
SHIFT+RIGHT SHIFT+RIGHT ACK

up upP SUB
SHIFT+UP SHIFT+UP SUB
DOWN DOWN LF
SHIFT+DOWN SHIFT+DOWN LF

ESC ESC ESC
SHIFT+ESC SHIFT+ESC Esc
ENTER RETURN CR
SHIFT+ENTER SHIFT+ENTER CR

KPD ENTER ENTER CR
SHIFT+KPD ENTER SHIFT+ENTER CR

F1 F1 STX 1 CR
SHIFT+F1 SHIFT+F1 STX ! CR
F2 F2 STX 2 CR
SHIFT+F2 SHIFT+F2 STX " CR
F3 F3 STX 3 CR
SHIFT+F3 SHIFT+F3 STX # CR
Fa4 F4 STX 4 CR
SHIFT+F4 SHIFT+F4 STX $ CR
F5 F5 STX 5 CR
SHIFT+F5 SHIFT+F5 STX % CR
F6 F6 STX 6 CR
SHIFT+F6 SHIFT+F6 STX & CR
F7 F7 STX 7 CR
SHIFT+F7 SHIFT+F7 STX ' CR
F8 F8 STX 8 CR
SHIFT+F8 SHIFT+F8 STX ( CR
F9 F9 STX 9 CR
SHIFT+F9 SHIFT+F9 STX ) CR
F10 F10 STX : CR
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PC Key
SHIFT+F10

F11

SHIFT+F 11

F12

SHIFT+F12
CTRL+F1
SHIFT+CTRL+F1
CTRL+F2
SHIFT+CTRL+F2
CTRL+F3
SHIFT+CTRL+F3
CTRL+F4
SHIFT+CTRL+F4
CTRL+F5
SHIFT+CTRL+F5
CTRL+F6
SHIFT+CTRL+F6

Terminal Key
SHIFT+F10
F11
SHIFT+F11
F12
SHIFT+F12
F11
SHIFT+F11
F12
SHIFT+F12
F13
SHIFT+F13
F14
SHIFT+F14
F15
SHIFT+F15
F16
SHIFT+F16

2.3.1.5 Viewpoint 60 Graphic Character Table

23.2

Sequence

STX

STX ;

*

STX +
STX <

STX
STX

STX +
STX <

STX
STX
STX
STX

STX .

STX
STX
STX

?
/
0

CR
CR
CR
CR
CR
CR
CR
CR
CR
CR
CR
CR
CR
CR
CR
CR

STX SPACE CR

The Viewpoint 60 Graphic Character Table defines the character code used for each of the line-
drawing graphic characters used by Viewpoint 60 emulation.

Graphic

_l__l_

|
}

ADDS Programming Notes

Code

@ or A or
D or E or
Hor I or
L or M or
P or Q or
T or U or
XoryY or
“oor ] or
Tordor
dore or

horior

[S=H

or C
or G
or K
or O
or 5
or W
or [
or

or C

or g
or k

< Functions tagged with the diamond symbol are only valid in Viewpoint 60 or Procomm VP60

emulation.
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2.4  ANSI Programming

The AccuTerm ANSI emulations provide VT52, VT100, VT220, VT320, VT420, SCO Console, Linux

Console and ANSI BBS emulations. The VT220, VT320 and VT420 emulations support international

characters, 7 and 8 bit control codes, programmable function keys and a robust command set. VT100
supports 7 bit control codes and a subset of the VT220 command set.

The SCO Console emulation uses the PC (OEM) character set and supports programmable function
keys and text and background colors.

The Linux Console emulation uses the ANSI character set, and includes support for programmable
function keys, text and background colors, and mouse.

The ANSI BBS emulation supports the PC (OEM) character set and the attribute and cursor commands
supported by the DOS ANSIL.SYS device driver (AccuTerm does not use the ANSIL.SYS driver). The
ANSI BBS emulation only supports 7 bit escape sequences.

When AccuTerm is emulating a VT220, VT320 or VT420 terminal snipor SCO or Linux Console, it will
respond to 7-bit and 8-bit control codes (hex 00-1F and 80-9F). For convenience, command sequences
which may use 8-bit control codes are documented using the 8-bit control code. For every 8-bit control
code, an equivalent 7-bit escape sequence may also be used, as shown in the following table:

csl = ESC |
SS3 = ESC O
DCS = ESC P
ST = ESC\

This chapter documents commands used by all of the ANSI emulations supported by AccuTerm. Not
every command is valid for all ANSI emulations. Those commands which are only valid for certain
emulations are shown with a reference note after the command definition. These reference are indicated

by a superscript, and are VT100 1 , VT220 2 , VT320 3 , VT420 4 , ANSI BBS A , Linux Console L , and
SCO Console S .

The AccuTerm ANSI emulations operate in a variety of modes. Some of the default operating modes are
determined by settings in the AccuTerm configuration. Most of these modes can be changed by
commands received from the host. Operating modes which can be selected in the Settings dialog and
saved in a configuration file are:

e VT52, VT100, VT220, VT320, VT420, SCO Console, Linux Console or ANSI BBS emulation

e 80 (normal) or 132 (extended) columns

e Automatic wrap at end of line

e Send 7 or 8 bit control codes

e Numeric keypad sends “application” codes instead of numbers

e Cursor keys send “application” codes instead of cursor codes
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e Backspace key sends DEL control code instead of BS control code

The following operating modes are not determined by settings in the AccuTerm configuration, but may be
changed by sending the appropriate ANSI command sequence:

e Keyboard: default is unlocked.

e Insert/Replace: default is replace.

e Line feed / New line: default is line feed.

e Origin: default is absolute.

e Tabs: default is every 8 columns.

e Cursor: default is on.

e Print extent: default is full screen.

¢  Printer form-feed: default is off.

e Graphics mode: default is off.
AccuTerm VT220, VT320 and VT420 emulations support 5 character sets: ASCII, Multinational, ISO-
Latinl, Graphics and Scientific. The default character set assignment is GO=ASCII, G1=ASCI,

G2=Multinational and G3=ASCII. The GL set (hex 20-7E) defaults to GO (ASCII) and the GR set (hex
AO-FE) defaults to G2 (Multinational).

Operating Modes

ESC c
Hard reset. Re-reads AccuTerm configuration file, then resets all operating modes and
character sets to their default values. Clears the screen and I/O buffer.
csli ! p
Soft reset. Resets all operating modes and character sets to their default values.234
CSIn+p
Secure reset. Re-reads AccuTerm configuration file, then resets all operating modes and
character sets to their default values. Clears the screen and I/O buffer. If n is non-zero, then
AccuTerm responds by sending €SI n * q back to the host. The value of n must be
between 0 and 16383. 1234
ESC SPACE F
Causes AccuTerm to send 7-bit control codes: 234
csi = |ESC |
SS3 = ESC O
DCS = ESC P
ST = |ESC \
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ESC SPACE G

csi

csl

(o]

CSI

csi

csi

csi

csi

csi

csi

csi

csi

csi

csi

12

12

20

20

Causes AccuTerm to send 8-bit control codes €SI, $S3, DCS and ST. 234
1" p
. 234
Changes the emulation to VT100.

2;n"p
Changes the emulation to VT220. If n = 1, AccuTerm will equivalent send 7-bit escape
sequences for control codes €SI, §83, bcS and ST; otherwise, 8-bit control codes will be

sent.234

3;n"p
Changes the emulation to VT320. If n = 1, AccuTerm will equivalent send 7-bit escape
sequences for control codes €SI, $83, DCS and ST; otherwise, 8-bit control codes will be

sent.234

4; n"p
Changes the emulation to VT420. If n = 1, AccuTerm will equivalent send 7-bit escape

sequences for control codes ¢Sl , 83, DCS and ST; otherwise, 8-bit control codes will be

sent.234

Locks the keyboard.
Unlocks the keyboard.
Enable display of control characters as symbols.
Disable display of control characters (execute control characters.
Insert mode on.
Insert mode off.
h
Full duplex (no local echo).
Half duplex (local echo).

h
Process LF, vT and FF as "new line"; that is perform carriage return and line feed.

|
Process LF, vT and FF as line feed.
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CSI

CSI

CSI

CSI

CSI

CSI

CSI

CSI

CSI

CSI

CSI

CSI

CSI

CSl 7

csl

(o]

42 h
Changes emulation to Wyse 60.
?1h
Cursor keys return application codes.
? 11
Cursor keys return cursor codes.
? 21
Enter VT52 emulation mode.
?3h
Extended video mode (132 columns).
? 31
Normal video mode (80 columns).
?5h
Light background, dark text.
? 51
Dark background, light text.
?6h
Causes cursor positioning to be relative to the currently defined scrolling region.
?6 1
Causes cursor positioning to be absolute (not relative).
?7h
Sets autowrap mode. When the cursor is on the last character of a line, receipt of another
character causes the cursor to mowe to the first column of the next line.
271
Resets autowrap mode. The cursor will not move past the last column of the line upon
receipt of another character.
?9horcsi0o$ ~

Status line off. 234
? 9|

Status line on.234
1%~

Display local status line. 234
2$ ~

Display host-writable status line. 234
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CSI

csi

csl

CSI 7

CSI 7

CSI 7

CSI 7

CSI 7

CSI 7

CSI 7

CSI 7

CSI 7

CSI

CSI

CSI 7

CSI 7

CSI

0$%$}

1%}

? 18 h

Data sent to screen's data area. 234

Data sent to host-writable status line. 234

Causes a form-feed character (hex OC) to be sent to the printer after each print screen.
No character is sent to the printer after each print screen.

Print screen command causes the full screen to be printed.

Print screen command only prints the currently defined scrolling region.

Cursor on.

Cursor off.

or GS or ESC 1
Enters Tektronix 4014 graphics mode.

or CAN or ESC 2
Exits Tektronix 4014 graphics mode.

Cursor keys return application codes. 234

Cursor keys return cursor codes. 234

Backspace keys sends BS control code. 34

Backspace keys sends DEL control code. 34

Enables vertical split screen mode. 4

Disables \ertical split screen mode. 4
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csl ? 95 |

€Sl ? 109 h

csl ? 109 |

ESC %!

csl 0

csl 3

CSI n

CSI n

CSI n

CSI n

csl ?

csl ?

CSI n

ESC =

0

Do not clear screen when column mode changes. 34

Clear screen when column mode changes. 34

Set CapsLock keyboard state.

Clear CapsLock keyboard state.

Enters Tektronix 4100 graphics mode.

SP q or CSI'1SPq or CSI 2 SPq

Select block cursor. 234

SP g or CSI 4 SP q

Select underscore cursor. 234

$ |
Set number of columns to n. 34

t or ¢SI n * |
Set number of rows to n. 3%

v g
Sets the terminal ID returned in response to the DA1 command. Valid values for n are: 0 =
VT100, 1 = VT101, 2 = VT102, 5 = VT220 and 6 = VT320. 34

* X
Selects if visual attributes which are modified by the DECCARA or DECRARA commands
are contained within the rectangular area defined by the beginning and ending positions. If n
= 0 or 1 then beginning and ending positions indicate locations in the character stream
displayed on the screen; if n = 2, then the beginning and ending positions indicate the
upper-left and lower-right corners of a rectangle. L

9 h
Enable mouse reporting. L

9 |
Disable mouse reporting. L

=L

Set erase mode. If n = 0, new lines and clear screen are filled with the current background

color. Otherwise, new lines and clear screen fill with the screen background color. S
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Numeric pad returns application codes.

ESC >Numeric pad returns numbers.

Character Set Selection

EsC ( B
Sets character set GO to ASCII (default). 1234L
ESC ) B
Sets character set G1 to ASCII (default). 1234L
ESC * B
Sets character set G2 to ASCII. 234L
ESC + B
Sets character set G3 to Ascll, 234k
ESC ( <
Sets character set GO to UPSS (the character set selected in the terminal settings). 234L
ESC ) <
Sets character set G1 to UPSS (the character set selected in the terminal settings). 234L
ESC * <
Sets character set G2 to UPSS (the character set selected in the terminal settings - this is
the default). 234
ESC + <
Sets character set G3 to UPSS (the character set selected in the terminal settings). 234
ESC ( A
Sets character set GO to ISO-Latin1. 1L
ESC ) A
Sets character set G1 to ISO-Latin1. 1L
ESC - A
Sets character set G1 to ISO-Latinl. 234
EsC . A
Sets character set G2 to ISO-Latin1.23%
EsC /| A
Sets character set G3 to ISO-Latinl.234
ESC ( O
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Sets character set GO to graphics. 1234L
ESC) O
Sets character set G1 to graphics. 1234L
ESC * O
: 234
Sets character set G2 to graphics.
ESC + O
Sets character set G3 to graphics. 234
ESC (S
Sets character set GO to scientific.234
ESC) S
Sets character set G1 to scientific. 234
ESC * S
e 234
Sets character set G2 to scientific.
ESC + S
Sets character set G3 to scientific. 234
ESC ( %5
Sets character set GO to Multinational. 1234
ESC ) %5
Sets character set G1 to Multinational. 1234
ESC * %5
Sets character set G2 to Multinational. 234
ESC + %5

Sets character set G3 to Multinational. 234

ESC ( K or ESC ( U
Sets character set GO to codepage 437. L

ESC ) K or ESC ) U
Sets character set G1 to codepage 437. L

ESC ( VT

Sets character set GO to codepage 437. LS

ESC ) VT

Sets character set G1 to codepage 437. LS
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ESC ( FF
Sets character set GO to upper half of codepage 437. LS
ESC ) FF
Sets character set G1 to upper half of codepage 437. LS
SI
Invoke character set GO into GL (the GL set corresponds to character codes in the range of
hex 20-7E); this is the default. 123415
so
Invoke character set G1 into GL. 12345
ESC ~
Invokes character set G1 into GR (the GR set corresponds to character codes in the range
of hex AO-FE). 234
ESC n
Invokes character set G2 into GL. 234
EsC }
Invokes character set G2 into GR (default). 234
ESC o
: 234
Invokes character set G3 into GL.
ESC |
Invokes character set G3 into GR. 234
S§S2 or ESC N
Invokes character set G2 into GL for the next character only. 234
S§S3 or ESC O

Invokes character set G3 into GL for the next character only. 234

Cursor Paositioning

BS

HT

LF

Moves the cursor back one space. If the cursor is at the beginning of the line, no action
occurs.

Mowes the cursor to the next programmed tab stop. If there are no more tab stops, the
cursor mowes to the right margin.

Mowes the cursor down one line. If the cursor is on the last line of the scrolling region, the
screen will scroll up one line.
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vr
Same as LF.
FF
Same as LF.
CR
Mowes the cursor to the left margin of the current line.
NEL or ESC E
Mowes the cursor to the first column of the next line of the scrolling region. If the cursor is
on the last line of the scrolling region, the screen will scroll up one line.
IND or ESC D
Mowves cursor down one line in the same column. If the cursor is on the last line of the
scrolling region, the screen will scroll up one line.
cSInT
Mowves cursor down n lines in the same column. If the cursor is mowed to the last line of the
scrolling region, the screen will scroll up. S
RI or ESC M
Mowes the cursor up one line in the same column. If the cursor is on the first line of the
scrolling region, the screen will scroll down one line.
csinS
Mowes the cursor up n lines in the same column. If the cursor is mowved to the first line of
the scrolling region, the screen will scroll down. S
CSI'n B or CSIn e
Mowves cursor down n lines in the same column.
cSI n E
Moves cursor down n lines and to the first column, 1234LS
cSI n A
Mowes the cursor up n lines in the same column.
cSIn F
Moves the cursor up n lines and to the first column. 1234LS
cSI n D

Mowes cursor left n columns.

CSI'n Cor CSIn a
Mowes cursor right n columns.

cSlline ; column H or CSlline ; column f
Mowe cursor to line line, column column.
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csin d

Mowes cursor to line n. 1234LS

cSIn G or €SIn °

Mowes cursor to column n. 1234LS

HTS or ESC H or €SI 0 W
Sets a tab stop at the column where the cursor is.

cSI 0 g or €SI 2 W

Clears a tab stop at the column where the cursor is. 12345

€SI 3 g or €SI 5 W

Clears all tab stops. 1234LS
CcSI ? 5 W
234
Sets tab stops every 8th column.
cSI n |
Mowe forward n tab stops. 234
cSIn Z

Mowe backward n tab stops. 234

CSIn V or CSInSPACE R
Display a preceding page. Ifnis 0 or 1, the previous page is displayed, otherwise n

specifies the number of pages back to be displayed. 234

€SIn U or €SInSPACE Q
Displays a following page. Ifnis 0 or 1, the next page is displayed, otherwise n specifies

the number of pages forward to be displayed. 234

CSIn SPACE P

Display page n. 234

cSlitop ; bottom r
Set scrolling region. The first line of the scrolling region is set to top; the last line to bottom.
Default values for top and bottom are 1 and 24 respectively. Once the scrolling region is
defined, if origin mode is set to relative, the cursor may be positioned into, but not out of,

the scrolling region. 1234LS

ESC 7 or CSI SALS
Sawe state (cursor position, video attribute, character set, autowrap, origin mode and protect
mode).

ESC 8 or cSI UALS

Restore state.
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cSl left ; right s
Sets the left and right margins to define a horizontal scrolling region. This command only
works when vertical split screen mode is enabled.

ESC 6
Mowe cursor left one column. If the cursor is at the left margin, all data within the margin
scrolls right one column. The column that shifted past the right margin is lost. 4

ESC 9
Mowe cursor right one column. If the cursor is at the right margin, all data within the margin
scrolls left one column. The column that shifted past the left margin is lost.#

ESC 8

Fill screen with upper-case “E”.

Erasing and Editing

csl 0 J
Erases from the cursor to the end of the screen, including the cursor position.
csli 1
Erases from the beginning of the screen to the cursor, including the cursor position.
csl 23
Erases the entire screen (the cursor position is not moved).
csl 0 K
Erases from the cursor to the end of the line, including the cursor position.
csl 1 K
Erases from the beginning of the line to the cursor, including the cursor position.
csl 2 K
Erases the entire line (the cursor is not moved).
csi? 01
Erases all unprotected characters from the cursor to the end of the screen, including the
cursor position.
csl? 11
Erases all unprotected characters from the beginning of the screen to the cursor, including
the cursor position.
csl ? 27
Erases all unprotected characters on the entire screen (the cursor position is not moved).
csl ? 0K
Erases all unprotected characters from the cursor to the end of the line, including the cursor
position.
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CSI

CSI

CSI

csi

csl

(o]

CSI

csi

csl

(o]

(o]

CSI

CSI

csi

?1
Erases all unprotected characters from the beginning of the line to the cursor, including the
cursor position.
?2
Erases all unprotected characters on the line (the cursor is not moved).
n X
- : w0 234LS
Erases n characters, beginning with the current cursor position.
n @
o w0 234LS
Insert n blank characters beginning at the current cursor position.
n L
Insert n blank lines beginning at the cursor line. 1234LS
n P
Delete n characters beginning at the current cursor position. 1234LS
n M
Delete n lines beginning at the cursor line. 1234LS
n
Insert n columns into the scrolling region beginning at the column that has the cursor. 4
n
Delete n columns from the scrolling region beginning at the column that has the cursor. 4
top ; left; bottom ; right; attrl; ...; attrn$ r
Changes \isual attributes in an area defined by top, left, bottom, right. The area to be
changed is either a character stream or rectangle as defined by the DECSACE command.
See ANSI Attribute Code Table for the attribute codes. 4
top ; left; bottom ; right; attrl; ...; attrn$ t
Reverse visual attributes in an area defined by top, left, bottom, right. The area to be
changed is either a character stream or rectangle as defined by the DECSACE command.
See ANSI Attribute Code Table for the attribute codes. 4
top; left; bottom ; right$ z

Erase characters in rectangle defined by top, left, bottom, right. 4

top ; left; bottom ; right$ {

Erase unprotected characters in rectangle defined by top, left, bottom, right. 4

ch; top; left; bottom ; right$ x

Fill rectangle defined by top, left, bottom, right with character ch (ASCII code). 4

CSI stop; sleft; sbottom ; sright; spg; dtop; dleft; dpg$v
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Copy rectangle defined by stop, sleft, shottom, sright, from page spg to page dpg at

location dtop, dleft. 4

Video Attributes

€SIn ; n... m
Selects video attributes and/or character foreground and background colors according to
the ANSI Attribute Code Table. Characters received after this command are displayed in
the selected \video attribute. If multiple parameters are used, their effects are cumulative (e.
g. 0;4;5 selects blinking-underlined). A parameter value of O resets all attributes.

csl 0" q
Unprotected mode. Characters received after this command are erasable using the “erase
unprotected characters” command. 234

csI 1" g
Protected mode. Characters received after this command are not erasable using the “erase

unprotected characters” command. 234

ESC # 3
Double-high line top. Causes the line containing the cursor to display the top half of a
double-high line. 1234

ESC # 4
Double-high line bottom. Causes the line containing the cursor to display the bottom half of
a double-high line. 1234

ESC # 5
Single-width line. Causes the line containing the cursor to display normal width characters.
1234

ESC # 6
Double-width line. Causes the line containing the cursor to display double width characters.
1234

CSI =nF
Sets the current normal foreground color to n. Refer to “AccuTerm Programming” chapter for
color values. >

csl =nG
Sets the current normal background color to n. S

CSI =nH
Sets the current reverse foreground color to n. S

CSI =n |

S

Sets the current reverse background color to n.
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ESC] P nrrggbb
Set Linux Console palette. N is a single hex digit indicating which palette entry to set;

rrggbb are the hex RGB color values to be set. L

ESC] R

Reset Linux Console palette. L

Printer Control

CcSI 0 i
Prints the screen display. Either the full screen or scrolling region may be selected, and a
form feed may be sent after printing (see Operating Modes section.
CcSl 10 i
Prints the screen display ignoring the print extent in effect. 34
CcSI ? 1
Prints the current cursor line.
CSI 5 i
Transparent print mode. Characters are printed, but not displayed.
CSI ? 5 i

Auto print mode. When the “Auto-print works just like a VT terminal” setting is enabled, a
line is printed from the screen when the cursor mowves off that line with an LF, FF, or vT
control code, or an autowrap occurs. Otherwise auto-print mode works just like Wyse auto-
print mode.

CSI 4 i or CSI ? 4 i
Cancel transparent or auto print mode.

CSI 2 i

Send screen to host. 234

Terminal Reports

€SI 0 c or ESC Z
Request primary device attributes. Depending on the current emulation and terminal ID in

effect, AccuTerm will respond: 12341

VT100: csI?1; 2c

VT220: csI?62; 1; 2; 6; 8c
VT320: cSI?63; 1; 2; 6:;: 8c
VT420: csir?64; 1; 2; 6,; 8c
Linux: cslI ? 6 c

cSI >0c

Request secondary device attributes. AccuTerm will respond: 234
CSI >41 ; 4 ; 1c
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CSI

csi

csi

CSI 7

CSI 7

CSI 7

CSI

CSI

CSI 7

CSI 7

CSI

n

n

n

n

n

n

Request tertiary device attributes. AccuTerm will respond (xxxxxxxx is the product serial

number in hexadecimal):

234

DCS ! |1 XXXxxxxx ST

Request terminal status. AccuTerm will respond:

CsI 0 n

Request cursor position. AccuTerm will respond:

Request cursor position and page. AccuTerm will respond:

cSlline ;

cSlline ;

column R

column ;

page R

Request printer status. If a printer is defined for the current configuration, AccuTerm will

respon
csI?10n
If no printer is defined the response will be:
csI?13n

Request status of user-defined keys. AccuTerm will respon
€SI ?20n

Request keyboard status. AccuTerm will respond: 234
0;

Request locator status. If the mouse is currently enabled, AccuTerm will respon
CcSI ?250n

d: 234

csl ?2 27 ;

0 ;

On

If the mouse is not enabled, the response will be:

€SI ?753n

d: 234

d:234

Request locator device type. If the mouse is currently enabled, AccuTerm will respond: 234

CsI ? 57 ;

1n

If the mouse is not enabled, the response will be:

Request macro space. AccuTerm will respon

CsI ? 57 ;

csl 0 * {

n

On

d: 234
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Request memory checksum. AccuTerm will respond: 234
pcsid! ~00O0O0 sT
CSI ? 75n
Request data integrity. AccuTerm will respond: 234
€SI ? 70n
cSl " v
Request displayed extent. AccuTerm will respond: 34
CcSl rows; columns; 1 ; 1 ; page " w
csin$p
Request state of ANSI mode n. AccuTerm will respond: 34
CSI n; value $ vy
csl?ns$p
Request state of private mode n. AccuTerm will respond: 34
CSI ? n; value $ vy
CSI + X
Request function key free memory. AccuTerm will respond: 34
CSI 804 ; 804 +y
csI1$w

Request cursor information report. AccuTerm will respond with a string encoded with the
current cursor state including position, page, attribute and character set. The string returned

can be use to restore the cursor state. The response string is:34

DCS 1 $ u string ST

DCS 1 $ t string ST

Restore cursor state. Use string returned from previous command. 34

CcSI 2 $w
Request tabstop report. AccuTerm will respond with a string encoded with the current tab

settings. The string returned can be use to restore the tabs. The response string is: 34

DCS 2 $ u string ST

DCS 2 $ t string ST

Restore tabstops. Use string returned from previous command. 34

DCS $ q setting ST
Request setting. Setting is formed by taking the last one or two non-numeric characters of

an ANSI command. The response is: 34

DCS 0 $ r string ST
You can use the response string to restore the setting; Simply add ¢s/ to the beginning of
the string and send it back to the terminal.

csI'1 $u
Request terminal state. The complete terminal state (cursor position, character set,
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attributes, screen size, key lock, etc.) is encoded into a string and returned to the host.

You can use this string to restore the state later. The response is: 34

DCS 1 $ s string ST

DCS 1 $ p string ST

Restore terminal state. String is the value returned from the previous command. 34

Programming Function Keys

The AccuTerm VT220, VT320, VT420, Linux Console and SCO Console emulations support the ability to
download up to 15 function key values (the shifted function keys Fé - F20) from the host computer. The
following device control sequence is used to program the function keys.

DCSn | key / value ; ... key/ value ST
If n is 1, old key definitions are replaced by new definitions; if n is 0, the definition of all 15
shifted function keys are cleared before loading any new definitions. The function key to be
programmed is specified by key according to the ANSI Function Key Table, and the
sequence for that key is specified by value. Value is specified in hexadecimal.

VT320 and VT420 emulations provide an extended method to program function and editing keys:

DCS" x key/ mod/ 100/ value/ 0; ... ST
The key to be programmed is specified by key according to the ANSI Extended Key Table,
and any modifier keys (SHIFT, CTRL, etc.) are specificed by mod, according to the same
table. The sequence for the key is specified by value in hexadecimal.

In addition, the VT420 emulation has user-definable macros. Use the following command to define
macros.

DcSid; dt; fn; en! z value ST
Id is a macro identifier, which must be in the range of 0 to 63. If dt is 1, then all current
macros are deleted before the new macro is defined. en specifies the encoding: 0 for ASCII
text, 1 for hexadecimal. Value is the macro contents in the specified encoding format.

Invoking a macro has the same effect as if the terminal had received the macro contents from the host.
The following command may be use to inwoke a defined macro:

estid * z 4

The SCO Console emulation uses the following sequence to program function keys:

ESC Q key delim value delim
key is a single ASCII character which designates which key to program. Function keys F1 to
F12 are selected by specifying 0 to; . For SHIFT+1 to SHIFT+F12 use < to G For CTRL+F1 to
CTRL+F12 use Hto S. For CTRL+SHIFT+F1 t0 CTRL+SHIFT+F12 use T to _. Delim is a single
character delimiter which encloses value.

CcSlI 2 + z

Restores default values to programmed keys. 34
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To program the Answerback message, use the following device control sequence:

DCS 1 v value ST
Note: the “Map F11 through F20 ...” check box in the keyboard settings must be checked to access
programmed function keys from F13 to F20. When this item is checked, function keys F11 - F20 are

mapped onto the control function keys; e.g. F15 is mapped to CTRL+F5, SHIFT+F13 is mapped to
CTRL+SHIFT+F3.

VT-52 Escape Sequences

ESC A

Cursor up.
ESC B

Cursor down.
ESC C

Cursor right.
ESC D

Cursor left.
ESC F

Enter line graphics mode.
ESC G

Exit line graphics mode.
ESC H

Cursor home.
ESC |

Rewerse line feed.
ESC J

Erase from cursor to end of screen.
ESC K

Erase from cursor to end of line.
ESC V

Print cursor line.
ESC ]

Print screen.
ESC W

Transparent print mode.
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241
2411

ESC X

Cancel transparent print mode.
ESC *

Auto print mode.
ESC _

Cancel auto print mode.
ESC =

Keypad application mode on.
ESC >

Keypad application mode off.
ESC <

Enter VT220 mode.
ESC Z

Identify terminal.
ESC Y line col

Cursor position.
ANSI Tables

ANSI Attribute Code Table

The ANSI Attribute Code Table defines the attribute code character (n) used by the ANSI emulations
to assign visual attributes.

Code (n) Attribute type

0 Normal

1 Bold

2 Dim

4 Underline

5 Blinking

7 Rewerse

8 Blank

22 Dimé& Bold off
24 Underline off

25 Blinking off

27 Reverse off

28 Blank off

30 Black character
31 Red character
32 Green character
33 Yellow character
34 Blue character
35 M agenta character
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Code (n) Attribute type

36 Cyan character

37 White character

40 Black background

41 Red background

42 Green background
43 Yellow background
44 Blue background

45 M agenta background
46 Cyan background

47 White background

2.4.1.2 ANSI Function Key Table

The ANSI Function Key Table defines the key code (key) used by the ANSI emulations to program
function keys.

Key to

program key
F6 17
F7 18
F8 19
F9 20
F10 21
F11 23
F12 24
F13 25
F14 26
F15 28
F16 29
F17 31
F18 32
F19 33
F20 34

2.4.1.3 ANSI Extended Key Table

The ANSI Extended Key Table defines the key code (key) and modifier keys (mod) used by the ANSI
emulations to program extended function and keypad keys.

Key to Modifier

program key keys mod
F1 112 none 0

F2 113 SHIFT 2

F3 114 ALT 3

Fa4 115 ALT+SHIFT 4

F5 116 CTRL 5

F6 117 SHIFT+CTRL 6
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Key to
program
F7

F8

F9

F10

F11

F12
BKSP
TAB
INS
DEL
HOME
END
PGUP
PGDN
LEFT
RIGHT
up
DOWN
ESC
ENTER
KPD ENTER

2.4.1.4 ANSI Key Code Table

key
118
119
120
121
122
123
14
16
75
76
80
81
85
86
79
89
83
84
110
42
108

Modifier
keys
ALT+CTRL

ALT+CTRL+SHIFT

mod

8

The ANSI Key Code Table describes the default character sequence transmitted by the function,
keypad and other special keys on the PC keyboard and the corresponding real terminal key.

PC Key
BKSP
SHIFT+BKSP
TAB
SHIFT+TAB
INS
SHIFT+INS
DEL
SHIFT+DEL
HOME
SHIFT+HOME
END
SHIFT+END
PGUP
SHIFT+PGUP
PGDN
SHIFT+PGDN
LEFT
SHIFT+LEFT

Terminal Key
BKSP
SHIFT+BKSP
TAB

SHIFT+TAB

DEL

DEL LINE
HOME
SHIFT+HOME

PGUP
SHIFT+PGUP
PGDN
SHIFT+PGDN
LEFT
SHIFT+LEFT

Sequence

BS
BS
HT
csl
csl
csl
DEL
DEL
csl
csl
csl
csl
csl
csl
csl
csl
csl
csl

Z
2
2

U g o oo aer ek T/T

l

l

Copyright © 2010-2014 Zumasys, Inc.



AccuTerm 7 Reference

Note: when using 7 bit controls, €SI is sent as ESC [ and SS3 is sent as ESC O

PC Key
RIGHT
SHIFT+RIGHT
up
SHIFT+UP
DOWN
SHIFT+DOWN
ESC
SHIFT+ESC
ENTER
SHIFT+ENTER
KPD ENTER
SHIFT+KPD ENTER
F1

F2

F3

F4

F5

F6

F7

F8

F9

F10

F11

F12

CTRL+F1
CTRL+F2
CTRL+F3
CTRL+F4
CTRL+F5
CTRL+F6
CTRL+F7
CTRL+F8
CTRL+F9
CTRL+F10

2.4.2 ANSIProgramming Notes

Terminal Key
RIGHT
SHIFT+RIGHT
up

SHIFT+UP
DOWN
SHIFT+DOWN
ESC
SHIFT+ESC
RETURN
SHIFT+ENTER
ENTER
SHIFT+ENTER
PF1

PF2

PF3

PF4

F6

F7

F8

F9

F10
F11
F12
F11
F12
F13
F14
F15
F16
F17
F18
F19
F20

Sequence

Csl
CSl
CSl
Csl
Csl
CSl
ESC
ESC
CR
CR
CR
CR
SS3
SS3
SS3
SS3
CSl
CSl
Csl
Csl
CSl
CSl
Csl
Csl
CSl
CSl
Csl
Csl
CSl
CSl
Csl
Csl
CSl
CSl

C

W W > >0

AW NPEP O 0O O™~ WSAWEL O OOO®N

95

Functions tagged with the following super-script symbols are only valid in the designated emulation:

1-VT100
2-VT220
3-VT320

4 -VT420

A - ANSI BBS

L - Linux Console
S - SCO Console
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2.5

Pick PC Console Programming

The Pick Operating System on the IBM PC has its own terminal type for the system console (term type
I). AccuTerm emulates the Pick PC console thus allowing you to use the same terminal codes for all
your terminals in a Pick PC environment. The advantage of using this emulation is that it gives you
direct access to legacy VGA colors and attributes.

Operating Modes

ESC * Y

ESC * |

GS

ESC %! O

Set the video mode to 80 by 25 monochrome mode. This command is ignored by
AccuTerm.

Sets the video mode to 80 by 25 color. This command is ignored by AccuTerm.

If the graphics mode is enabled, this command puts the terminal in the Tektronix emulation
mode. If the graphics mode is disabled, this command is ignored.

Enters Tektronix 4100 graphics mode.

Cursor Paositioning

BS or ESC * HT

ESC * DC3

LF

ESC * LF

CR

ESC * STX

ESC =cr

Cursor left. The cursor is moved left one position. If the cursor is at the first column, it is
moved to the last column of the previous line.

Cursor right. Mowves the cursor right one position. If the cursor is at the last column, it will
wrap to the first column of the next line.

Cursor down. Movwves the cursor down one row. If the cursor is on the last row of the screen
and the terminal is not in protected mode, the screen scrolls up one line.

Cursor up. Mowves the cursor up one row. If the cursor is at the top row and the terminal is
not in protected mode, the screen is scrolled down one line.

Carriage return. Mowes the cursor to the leftmost column of the current row.

Cursor home. Movwes the cursor to the upper left corner of the screen.

This command positions the cursor to column c and row r. ¢ and r are the binary cursor
positions, numbered from O (top row, left column). For example, to position the cursor to
column 10 row 10, you would send ESC = LF LF where LF is the ASCII representation of
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character 10.

Erasing and Editing

FF or ESC * SOH
Clears the screen and mowves the cursor to the upper left corner of the screen.

ESC * ETX
Clears from the cursor position to the end of the screen.

ESC * EOT
Clears from the cursor position to the end of the line.

ESC * h
Insert character. A blank is inserted at the current cursor position. All characters from the
cursor position to the right are mowved right one column.

ESC * i
Delete character. The character at the current cursor position is deleted. All characters to
the right of the cursor are mowed left one column and a blank is placed on the last column of
the line.

ESC * j
Insert line. A blank line is inserted before the current line. The current line and all lines
below are moved down one row. The bottom line of the screen is lost. The cursor is moved
to the left most column of the inserted line.

ESC * k

Delete line. The current line is deleted. All lines below the current line are moved up one
position. The bottom line is blank. The cursor is moved to the left most column.

Video Attributes

In Pick PC Console emulation there are several different ways to set the video attributes. The first is
through escape sequences that start and stop individual attributes like "Underline", "Rewerse", etc. The
second is by sending the desired foreground and background colors. Note that the PC Console treats
the "Dim" attribute as the protected attribute. To change video attributes, use the following escape
seqguences.

ESC * ENQ
Start blinking characters.

ESC * ACK
Stop blinking characters.

ESC * BEL
Start dim (protected) characters.

ESC * BS
Stop dim (protected) characters.
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251

ESC * CR

Start reverse video characters.
ESC * SO

Stop reverse video characters.
ESC * SI

Start underlined characters.
ESC * DLE

Stop underlined characters.
ESC * n

Sets the foreground/background attributes separately where n is the code from the PC
Console Color Code Table.

Protected Attributes

The Pick PC Console emulation uses the dim attribute as the protected attribute. When the protect
mode is enabled, the cursor is not allowed to move to any positions that contain protected characters,
the auto scroll mode is turned off, and the clear screen functions clear only the un-protected characters.

ESC * VT
Turn on the protected mode.
ESC * FF
Turn off the protected mode.
ESC * BEL
Start protected (dim) characters.
ESC * BS

Stop protected (dim) characters.

Printer Control

ESC [ ? 5 i or ESC * DcC1
Transparent print mode. Characters are printed, but not displayed. When AccuTerm
receives this command, it goes into transparent print mode until it receives the ANSI print off
sequence below. This command is useful for printing graphics data to the printer. Since
AccuTerm requires the specific ANSI cancel command below to exit transparent print mode,
there is less chance of a control character interrupting the graphic printing.

ESC[ ? 4 i orEsSC * DC2

Cancel transparent print mode.

PC Console Color Code Table

The PC Console Color Code Table defines the color code character (n) used by the Pick PC Console
emulation to assign the foreground and background colors.
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Color
White
Yellow
Magenta
Red
Cyan
Green
Blue
Black

Background
!

#

%

Bright foreground

Dim foreground
9

@'\)V

99

Copyright © 2010-2014 Zumasys, Inc.




100 AccuTerm 7 Lite Help

2.6 ASCIl Control Codes

ASCII Control Codes

The ASCII Control Codes chart lists the ASCII 7-bit control codes, along with their decimal and
hexadecimal values and the keyboard keys used to produce the code. The ANSI 8-bit control codes are
shown at the end of the table along with their 7-bit equivalents.

ASCII 7-bit Decimal Hex Key
control char

NUL 0 00

SOH 1 01 CTRL+A
STX 2 02 CTRL+B
ETX 3 03 CTRL+C
EOT 4 04 CTRL+D
ENQ 5 05 CTRL+E
ACK 6 06 CTRL+F
BEL 7 07 CTRL+G
BS 8 08 CTRL+H
HT 9 09 CTRL+
LF 10 0A CTRL+J
VT 11 0B CTRL+K
FF 12 0oC CTRL+L
CR 13 0D CTRL+M
) 14 OE CTRL+N
SI 15 OF CTRL+0
DLE 16 10 CTRL+P
DC1 17 11 CTRL+Q
DC2 18 12 CTRL+R
DC3 19 13 CTRL+S
DC4 20 14 CTRL+T
NAK 21 15 CTRL+U
SYN 22 16 CTRL+V
ETB 23 17 CTRL+W
CAN 24 18 CTRL+X
EM 25 19 CTRL+Y
SuUB 26 1A CTRL+Z
ESC 27 1B CTRLH
Fs 28 1C CTRLH
GS 29 1D CTRL4
RS 30 1E CTRL+
us 31 1F CTRL+_
DEL 127 7F

ANSI 8-bit

control char Decimal Hex 7-bit equivalent
IND 132 84

NEL 133 85
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ASCII 7-bit
control char
SSA

ESA

HTS

HTJ

VTS

PLD

PLU

RI

S§S2

§S3

DCS

PU1

PU2

STS

CCH

Mw

SPA

EPA

CSI
ST
0sC
PM
APC

Decimal

134
135
136
137
138
139
140
141
142
143
144
145
146
147
148
149
150
151
152
153
154
155
156
157
158
159

Hex

86
87
88
89
8A
8B
8C
8D
8E
8F
90
91
92
93
94
95
96
97
98
99
9A
9B
9C
9D
9E
9F

Key

ESC O
ESC P

ESC [
ESC \
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2.7

Customizing the Installation Process

The AccuTerm 7 installation process can be customized in several ways: default values can be supplied
for any of the installation wizard prompts, the installer can run in "silent mode”, you can supply your own
files to be installed along with the AccuTerm 7 program files, and the MSI can be extracted to facilitate
deployment using Active Directory and Group Policy.

The AccuTerm 7 installer is distributed as a single EXE file. The installer can be placed in any folder that
is accessible to the user's PC: local hard drive, portable drive such as a USB drive, network share, CD-
ROM, etc. The EXE wraps an MSI install file and launches the MSI installer (msiexec) with appropriate
options based on the install type selected.

Supplying default values for installation prompts

To supply default values for installation prompts, you need to create a text file called 'setup.ini* and place
it in the same directory that the AccuTerm 7 installation EXE file resides. A sample 'setup.ini’ file is
shown below:

; Custom setup for AccuTerm 7.1

; Use atw7l.exe /silent or /verysilent for a "quiet" unattended
i nstallation

- ltems which can be defined:

[ Def aul t s]

; MAI NDI R=Pr ogram Fil es\ Atwi n71
; HOVEDI R=My Docunent s

; DESKTOPSHORTCUT=Y

; ALLUSERS=Y

; ACTI VATI ONCODE=123456789- 123456789
. AUTOACTI VATE=Y

; NAME=your nane

; COMPANY=your conpany

; ADDRESS=your address

; LOCATI ON=your | ocation

; CIl TY=your city

; STATE=your state

; ZI PCODE=zi p or postal code

; COUNTRY=your country

; EMAI L=you@onpany. com

[ Cust onFi | es]
; Mai n=f ol der containing extra files copied to the main programdirectory
; Home=f ol der containing files to copy to the default “home” directory

[ Cust omShort cut ]

; Name=nane of shortcut
; Target=path to .exe, .atcf, .atly or .atsc file (can use %IOVEDI R% or %
IMAI NDI R% prefix for path)

;lcon=path to file containing icon (can use %HOMEDI R% or %VAIl NDI R%
prefix for path)

;I ndex=n (index of icon, if icon is contained in an exe file with
mul ti ple icons)

; State=n (initial wi ndow state: 1=normal, 2=m nim zed, 3=nmaxim zed)
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To use the 'setup.ini' sample shown abowe, remowe the leading ';' from any items you need to define, and
enter the value you want to use after the equal sign. Remowve the comment text from any lines that you
define. Any items that are not defined will use the default for that setting.

The MainDir entry may begin with the text "Program Files" which will be replaced during the installation
with the appropriate directory for program files (usually C:\Program Files or C:\Program Files (x86) ).

The HomeDir entry may begin with the text "My Documents" which will be replaced during installation
with the public Documents directory (Normal install) or the current user's Documents directory (Personal
install). Subdirectories are allowed.

In the [CustomShortcut] section, the Target and Icon entries may begin with the tokens %MAINDIR%
and %HOMEDIR%. These tokens will be replaced with the appropriate directory during installation.

Unattended Installation

The AccuTerm 7 installer uses command-line options to perform an unattended installation. To perform
an unattended installation, you must indicate your acceptance of the software license agreement by
including the /LICENSEACCEPTED=YES command-line option.

The "/SILENT" command-line option bypasses all of the installation prompts, but does display a
progress bar during installation:

lat i t e71a. exe / SI LENT /LI CENSEACCEPTED=YES |

The "/VERYSILENT' command-line option bypasses all of the prompts and does not display the
progress bar:

lat 1i t e71a. exe / VERYSI LENT / LI CENSEACCEPTED=YES |

If you intend to use the 'setup.ini' file to specify answers to the installation prompts during an unattended
installation, you can include the following line in the [Defaults] section of the 'setup.ini' file to indicate
your acceptance of the software license agreement. By including this line in 'setup.ini’, you no longer
need to include it on the command line.

[LI CENSEACCEPTED=YES |

Extracting the MSI file from the EXE installation file
To extract the MSI file from the EXE installer, run the EXE with the /EXTRACTMSI command line option:

latli t e71a. exe / EXTRACTMEI |

The EXE installer will prompt for a target directory where the MSI file will be stored.

Installing AccuTerm directly using MSI

Once the MSI file has been extracted from the EXE, you can use the msiexec command to install
directly from the MSiI file. You may specify certain MSI properties on the msiexec command line.
Common properties are INSTALLDIR, ALLUSERS, and MSIINSTALLPERUSER. In order to use setup.ini
as described abowe, specify the SETUPINI property on the command line (the value is the name of the
setup.ini file). For example:

|msi exec /i atlite7l.msi ALLUSERS="1" SETUPI NI ="setup.ini" |
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3 Copyright & Trademarks

Copyright Notices

This document and the accompanying software are copyright 2010-
2014 Zumasys, Inc.

Freeimage:

The accompanying software uses the Freeimage open source image
library. See http://freeimage.sourceforge.net for details. Freeimage is
used under the Freeimage Public License version 1.0.

DejaVu Fonts:
Fonts are (c) Bitstream (see below). DejaVu changes are in public
domain. Glyphs imported from Arev fonts are (c) Tavmjong Bah.

Bitstream Vera Fonts:

Copyright (c) 2003 by Bitstream, Inc. All Rights Resened. Bitstream
Vera is a trademark of Bitstream, Inc.

Trademark Notices

AccuTerm is a trademark of Zumasys, Inc.
Bitstream Vera is a trademark of Bitstream, Inc.

DEC, VT52, VT100, VT220, VT320 and VT420 are trademarks of Digital
Equipment Corp.

IBM is a registered trademark of International Business Machines
Corp.

Microsoft and Microsoft Windows are registered trademarks of
Microsoft Corp.

Procomm is a trademark of Datastorm Technologies, Inc.
Tektronix 4010/4014/4100 is a trademark of Tektronix, Inc.
Viewpoint is a trademark of Applied Digital Data Systems.
Wyse-50 and Wyse-60 are trademarks of Wyse Technology.

Other trademarks and registered trademarks appearing in this
document are the property of their respective owners.
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Activating an evaluation version

ADDS 27

ADDS 4000 65
ADDS Viewpoint 65
ADDS Viewpoint Enhanced
ANSI 27, 34
Answerback 27
Application Mode 27
ASCIl Codes 100
Attributes 30, 32
atwin.ini 102
atwin71.ini 102
Authentication 20
Auxiliary port 35

B -

background image 40
Backspace 27

Baud Rate 25, 26
Beep 35

Blinking 32

Border colors 32
Border style 30, 32
Break Key 19, 20

_C -

CapsLock 32
Certificate 23
character encoding 34
character set 34
Cipher 5, 20

Citrix 5

Classic Windows 30
Client certificate 23
Clipboard Settings 37

Color 30, 32
Color Scheme 30
Color Settings 30, 32

Comport 8

Comm Port 25

Commands
Private 40

Configuring AccuTerm 17
Connection settings 18
Connection Wizard 7
Baud rate 8
Data bits 8
Handshake 8
Modem 9

Parity 8

Secure Shell 8
Serial Port 8
SSH 8

Stop bits 8
Telnet 8
Terminal Type 9
Console 27, 96
Control Characters 100
Control Codes 100
Copy/Paste 12
Copyright 105
Creating SSH keys 22
Custom installation 102

D -

Data Bits 25, 26
Data Capture 12
Default Colors 30
DejaVu font 34
Device driver 35
Device Licensing 18
Device settings 18

Dialer 10
Dialup 10
Dial-up 9

Disconnect 18
Disconnect Warning 10

DSA key 22
Dtr/Dsr 25, 26
Duplex 18
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Font Settings 34
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Hardware Requirements
History 12
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Internet Explorer 5, 20
Introduction 4
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Keepalive 19, 20

Key Fingerprint 22

Key Management 22
Key Types 32
Keyboard Commands 12
Keyboard Settings 32

L -

Latin-1 34
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Legacy font 34
License 11

Line Drawing 30, 32
Linux 27
Loopback 18

M -

Main Menu 12
Main Window 12
Menu 12
menu.ini 102
MM-MON 96
Modem 9, 10, 26
Modem settings 26
Modern Windows 30
Monochrome 30
Mouse 29

host control of 40
Mouse Wheel 29

-N -

New connection 7
Normal installation 5

-0 -

OpenSSH 22
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_P-

Palette 32

Parity 25, 26
Password 20
Pause 12

PC-MON 96

Pick PC Console 96
Pick PC Monitor 27
Portable installation 5
Pre-configured installation package 102
Print Screen 12
Printer driver 35
Printer Settings 35
Prism 27

Private Commands 40
Private Key 20
Procomm 65
Product activation 11
Programming AccuTerm 40
Protected Attribute 29
Public Key 20
Punycode 19, 20
putty 22

puttygen 22

_Q_

Quiet installation 102

‘R -

Registration 11
Requirements 5
Resume 12

RSA key 22
Rts/Cts 25, 26
Running AccuTerm 7

_S-

SCO 27

Screen print 35
Screen Settings 29
Screen Size 29
Scrollback 12, 29

Scrollbar 29
Secure Shell 5, 8, 20
Selecting text 12
Serial Port 8, 25
Serial port settings 25
Sener validation 23
Session lcon 29
Session Title 29
Settings
Attribute Colors 32
Clipboard 37
Colors 30, 32
Font 34
General 17
Keyboard 32

Modem 26
Palette 32
Printer 35

Public Key 22
Screen 29
Secure Shell 20, 22
Serial Port 25
Sound 35
SSL/Telnet 23
Telnet 19, 23
Terminal Type 27
setup.ini 102
Silent installation 102
Slave port 35
Slave printer 35
Software License Agreement 102
Software Requirements 5
Sounds 35

Speaker 35
SSH 8,20
SSL 23

SSL/Telnet 23
Standalone installation 5
Status Bar 12

Status Lines 27

Stop Bits 25, 26
System Colors 30

_T -

TCP/IP 19, 20, 23
Technical support 39
Tektronix 27
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wallpaper 40

Windows Terminal Server 5
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Wyse 50 46
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